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MACUSER News and Analysis About 
Macs, OS X, and AppleMACUSER News and Analysis About 
Macs, OS X, and Apple

Ta-dah! Touch Bar is the highlight 
of Apple’s newest MacBook Pro
Apple finally—finally!—updated its high-end laptop with new keyboard functionality, 
processors, and more.

BY ROMAN LOYOLA



MACUSERMACUSER APPLE’S NEWEST MACBOOK PRO

I
t’s been rumored for some time, and it even made an 
appearance in the macOS Sierra 10.12.1 update (go.macworld.
com/toolbarleak), but on October 27th Apple officially 
revealed a new MacBook Pro. The killer surprise-and-delight 

feature? It’s called Touch Bar, an OLED panel that replaces the 
row of function keys usually found on the top of the Apple laptop 
keyboard.

The Touch Bar does a lot of things, 

but the headline feature may be 

support for Touch ID. When you 

encounter a process that requires 

you to show your fingerprint (such as 

Apple Pay), you place your finger on 

the Touch ID area of the Touch Bar. 

The Touch ID sensor is integrated 

with the power button.

The functions provided by the 

Touch Bar change based on the 

software you are using. For example, 

ADOBE PHOTOSHOP CAN 

use the Touch Bar to 

perform image edits.

8
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if you’re using iTunes, the Touch Bar 

lights up with icons representing 

player controls. During a chat, the 

Touch Bar can be used to instantly 

place emoji. In the Photos app, you 

can access editing functions on the 

Touch Bar and apply those edits to 

the photo you’re working on.

Customizing the Touch Bar can be 

done using drag and drop. You can 

select the functions you want on the 

main screen, and drag them to the 

location you want off the bottom of 

the MacBook Pro’s screen and onto 

the Touch Bar.

During the Mac event, Apple said 

that third-party software developers 

will be able to create Touch Bar 

controls for their software. Adobe 

showed how the Touch Bar can be 

used to perform image edits in 

Photoshop. Algoriddim demonstrated 

how a DJ can use the company’s 

Djay software and the Touch Bar to 

perform mixes. Apple’s Phil Schiller 

also said that Microsoft will be offer-

ing Touch Bar tools for Microsoft 

Office.

Apple updated the Force Trackpad, 

too, which is now double the size of 

the previous trackpad. The new 

keyboard takes its cues from the 

12-inch MacBook; the MacBook Pro 

keyboard is based on butterfly switch 

technology, but Apple called this a 

“second generation” butterfly switch 

that’s more responsive to better suit 

the demands of pro users.

DESIGN CHANGES, 

THUNDERBOLT 3

The all-aluminum case design of the 

new MacBook Pro is thinner and 

lighter, and available in silver and 

space gray. The 13-inch model is 

14.9mm thin, 23 percent smaller than 

the previous 13-inch model, and 3 

pounds. The 15-inch model is 15.5mm 

thin, 20 percent smaller than the 

pre vious 15-inch model, and 4 pounds.

THE MACBOOK PRO 

relies on Thunderbolt 

3 ports for 

connectivity.



MACUSER

To help cut down on the weight 

and size on the MacBook Pro,  

Apple shrunk down the size of the 

speakers. But according to the 

company, there’s no sacrifice in audio 

performance; Apple claims that the 

speakers have twice the dynamic 

range, 58 percent more volume, and 

2.5 times more bass response than 

those of its predecessor.

The most drastic change is to the 

ports. Apple is going all in with 

Thunderbolt 3, providing multiple 

Thunderbolt 3 ports on the MacBook 

Pro—there are no USB-A ports. 

There’s also no MagSafe adapter 

port; charging is done through 

Thunderbolt 3. The MacBook Pro’s 

Thunderbolt 3 support USB-C, so 

users can still connect their USB 

devices, but you’ll need a USB adapter.

While it seems like Apple is doing 

what it can to make the headphone 

jack obsolete, it still lives on the 

MacBook Pro—it’s the only other port 

type featured on this new machine. 

The MacBook Pro no longer has an 

HDMI port. The SD Card slot is gone, 

too.

IMPROVED DISPLAY  

AND GRAPHICS

According to Apple, the LED-backlit 

IPS displays in the new MacBook Pro 

APPLE’S NEWEST MACBOOK PRO

THE 15-INCH MACBOOK 

Pro uses AMD 

graphics processors.

10
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are now 67 percent brighter, have a 

67 percent higher contrast ratio, and 

can display 25 percent more colors 

than previously. The displays offer 

500 nits of brightness and support 

for the P3 wide color gamut.

The 13-inch MacBook Pro has a 

2560-by-1600 native resolution (227 

pixels per inch). Supported scaled 

resolutions are 1680 by 1050, 1440 

by 900, and 1024 by 640.

The 15-inch MacBook Pro has a 

2880-by-1800 native resolution (220 

pixels per inch). Supported scaled 

resolutions are 1920 by 1200, 1680 

by 1050, 1280 by 800, and 1024 by 

640.

The 15-inch model uses an AMD 

Radeon graphics cards. The standard 

configuration uses a Radeon Pro 450 

with 2GB of graphics memory and can 

run two external 5K displays. Apple 

offers buyers the option to upgrade 

the graphics to a Radeon Pro 460 

with 4GB of graphics memory that 

and run up to four 4K displays.

The 13-inch models have Intel  

Iris Graphics, which are integrated 

with the main CPU. The low-end  

Intel Iris Graphics 540 can run  

one external 5K display, which the 

Intel Iris Graphics 550 can run two 

4K displays.

13-INCH MACBOOK PRO

> $1,499 13-inch MacBook Pro 

(no Touch Bar): 2GHz dual-core Core 

i5 processor, 8GB memory, 256GB 

SSD, Intel Iris Graphics 540, two 

Thunderbolt 3 ports

> $1,799 13-inch MacBook Pro 

(with Touch Bar): 2.9GHz dual-core 

Core i5 processor, 8GB memory, 

256GB SSD, Intel Iris Graphics 550, 

four Thunderbolt 3 ports

> $1,999 13-inch MacBook Pro 

(with Touch Bar): 2.9GHz dual-core 

Core i5 processor, 8GB memory, 

512GB SSD, Intel Iris Graphics 550, 

four Thunderbolt 3 ports

15-inch MacBook Pro

> $2,399 15-inch MacBook Pro 

(with Touch Bar): 2.6GHz quad-core 

Core i7 processor, 16GB memory, 

256GB SSD, 2GB AMD Radeon Pro 

450 Graphics, four Thunderbolt 3 

ports

> $2,799 15-inch MacBook Pro 

(with Touch Bar): 2.7GHz quad-core 

Core i7 processor, 16GB memory, 

512GB SSD, 2GB AMD Radeon Pro 

455 Graphics, four Thunderbolt 3 

ports ■

PODCAST
Listen to our 

podcast about 

the new Mac 

Book Pro (go.

macworld.com/

podcast531).
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Meet Apple’s 
complete 
MacBook lineup
Apple unleashed three new MacBook Pros 
during its October event. Here’s a closer look at 
each one, the dates you can get them, and how 
much they cost.

BY LEAH YAMSHON
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A
fter September’s annual iPhone-focused event, it was 
time for the Mac to have its turn in the spotlight. And 
boy, did we get some major Mac news on October 
27: Apple revealed three new MacBook Pros (see 

page 7), two of them featuring the Touch Bar, Apple’s brand-new 
touch control panel at the top of the keyboard. The MacBook Pro 
got a minimal refresh in October 2015 to introduce the Force 
Touch trackpad, but it’s been a minute since the line has seen a 
major update. 

As new products come in, old 

products must go out—so Apple’s 

complete MacBook lineup now 

looks a little different. Here’s a look 

at each MacBook in Apple’s collec-

tion, including information on 

pricing and on-sale dates for the 

just-announced Pros.

APPLE’S COMPLETE MACBOOK LINEUPMACUSER
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THE NEW MACBOOK PRO

The 2016 MacBook Pro is available in three versions: two 13-inch models, one 

featuring the Touch Bar and one featuring standard function keys, and a 

15-inch model with the Touch Bar (go.macworld.com/buymacbookpro).

13-INCH, WITHOUT TOUCH BAR

Price: Starts at $1,499 

Configuration: 2GHz dual-core Core 

i5 processor, 8GB memory, 256GB 

SSD, Intel Iris Graphics 540, two 

Thunderbolt 3 ports

When can I get it? You can get it 

right now!

13-INCH, WITH TOUCH BAR

Price: $1,799 for a 256GB SSD, 

$1,999 for 512GB SSD 

Configuration: 2.9GHz dual-core 

Core i5 processor, 8GB memory, 

256GB/512GB SSD, Intel Iris  

Graphics 550, four Thunderbolt  

3 ports 

When can I get it? Preorders 

started the day of the event; these 

Pros are expected to ship started 

November 10

15-INCH, WITH TOUCH BAR

The 15-inch 2016 MacBook Pro 

comes in two standard configura-

tions, both of which feature the 

Touch Bar:

Price: $2,399 

Configuration: 2.6GHz quad-core 

Core i7 processor, 16GB memory, 

256GB SSD, 2GB Nvidia Radeon Pro 

450 Graphics, four Thunderbolt 3 

ports

Price: $2,799 

Configuration: 2.7GHz quad-core 

Core i7 processor, 16GB memory, 

512GB SSD, 2GB Nvidia Radeon Pro 

455 Graphics, four Thunderbolt 3 

ports

When can I get it? Preorders for 

both versions started the day of the 

event; shipping started November 10
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APPLE’S COMPLETE MACBOOK LINEUPMACUSER

THE OLD MACBOOK PRO 

Does the price range of the 2016 MacBook Pro make you sick to your 

stomach? We feel you, and so does Apple. They’re keeping an older  

Pro model in the lineup as an entry-level machine, in both a 13-inch and 

15-inch configuration (go.macworld.com/buymacbookpro).

13-INCH

Price: $1,299

Configuration: 2.7GHz dual-core 

Intel Core i5 processor, Turbo Boost 

up to 3.1GHz, 8GB 1866MHz memory, 

128GB PCIe-based SSD, Intel Iris 

Graphics 6100, two Thunderbolt 2 

ports 

When can I get it? Right now!

15-INCH

Price: $1,999 

Configuration: 2.2GHz quad-core 

Intel Core i7 processor, Turbo Boost 

up to 3.4GHz, 16GB 1600MHz 

memory, 256GB PCIe-based SSD, 

Intel Iris Pro Graphics, two Thunder-

bolt 2 ports 

When can I get it? Right now!
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MACBOOK

Apple’s 12-inch notebook launched in 2015, and introduced us to a ton of new 

features that other MacBooks now have (like the Force Touch trackpad, 

butterfly key mechanism, and USB-C port). Though we didn’t hear anything 

about it during the recent event, it’s definitely still around, in four colors (to 

match your iPhone, naturally). You have two standard options to choose from 

(go.macworld.com/buymacbook):

Price: $1,299 

Configuration: 256GB PCIe-based 

onboard flash storage, 1.1GHz dual-

core Intel Core m3 processor with 

Turbo Boost up to 2.2GHz, 8GB 

memory, Intel HD graphics 515

When can I get it? Right now!

Price: $1,599 

Configuration: 512GB PCIe-based 

onboard flash storage, 1.2GHz 

dual-core Intel Core m5 processor 

with Turbo Boost up to 2.7GHz, 8GB 

memory, Intel HD graphics 515 

When can I get it? Right now!
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APPLE’S COMPLETE MACBOOK LINEUPMACUSER

MACBOOK AIR

Some bad news for MacBook Air fans: Apple quietly killed the 11-inch MacBook 

Air, and while the 13-inch Air is currently still available, Apple won’t be updating 

it (go.macworld.com/no11inmacbookair) going forward. However, Apple did 

make a point of comparing the Touch Bar–free 13-inch iPad Pro to the Air, 

noting that this new model is smaller and lighter than the Air while offering more 

power. The 12-inch standard MacBook has also been compared to the Air.

For now, here’s what you’ll find in the last remaining Air: 

Price: $999 for 128GB of storage; 

$1,199 for 256GB of storage 

Configurations: 1.6GHz dual-core 

Intel Core i5 processor with Turbo 

Boost up to 2.7GHz, Intel HD  

graphics 6000, 8GB memory, 

128GB/256GB PCIe-based flash 

storage 

When can I get it? Right now (go.

macworld.com/buymacbookair)! ■
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7 technologies killed in 
Apple’s new MacBook Pro
R.I.P. HDMI, SD cards, and more.

BY BRAD CHACOS
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A
pple’s never been shy about shaving off features in its 
quest for slimmer, faster computing. The new 
MacBook Pro lineup is no exception. Following in the 
footsteps of the radical 12-inch MacBook, the 

revamped MacBook Pro and its slick Touch Bar cull several old 
standbys from its design—and kill one of its siblings in the 
process. Here are seven technologies eradicated in the new 
MacBook Pro notebooks. For more details on whether we think 
the eliminations are worthwhile, check out Macworld’s MacBook 
Pro hands-on impressions (see page 79).

MAGSAFE

This hurts. This really hurts.

The MacBook’s vaunted, brilliant 

MagSafe used magnets to gently 

attach your power cord to your 

laptop, rather than relying on a hard 

connector jammed inside a port. 

MagSafe clamped on tightly enough 

to stay stable under normal condi-

tions, but lightly enough to discon-

nect when tugged—a literal laptop 

lifesaver when, say, a dog or child 

streaks across a room and trips over 

your cord.

The new MacBook Pro relies on 

USB-C for power instead, just like the 

aforementioned 12-inch MacBook. It’s 

a more flexible, industry-standard 

charging solution for sure…but I still 

can’t help but mourn MagSafe’s loss.

SD CARD SUPPORT

The SD card slot on MacBooks 

comes in handy for photographers 

and folks looking to expand their 

laptop’s storage (go.macworld.com/

tardiskpear)—or at least it used to. 

The overhauled MacBook Pro 

7 TECHNOLOGIES KILLED IN THE NEW MACBOOK PROMACUSER

THE NEW MACBOOK 

Pro’s ports are 

limited to USB-C.

PHOTOGRAPH BY JASON SNELL
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ditches native SD card support as 

well as most other auxiliary connec-

tions. It’s streamlined down to four 

USB-C/Thunderbolt 3 connections 

and a solitary audio jack. (Note that 

the all-in reliance on USB-C means 

traditional USB peripherals won’t 

work with the MacBook Pro unless 

you pick up some adapters.)

HDMI

Better pick up a USB-C–to–HDMI 

connector while you’re at it, if you 

plan on connecting your notebook to 

an external display.

DISCRETE ESC AND 

FUNCTION KEYS

That swanky new OLED strip of 

adaptive touchscreen keys in the 

new MacBook Pro needed to fit in 

somewhere. That “somewhere” is 

where the MacBook’s Escape and 

function keys previously called home, 

just underneath the display. Don’t 

weep for their loss, though: The 

Escape and function keys are gone 

but not forgotten, with digital doppel-

gangers springing to life on the 

Touch Bar when needed.

MACBOOK AIR

It looks like the end of the line for 

the beloved MacBook Air series. 

Apple killed the 11-inch MacBook Air 

(go.macworld.com/no11inmacbookair) 

outright when it launched the 

MacBook Pro and all but said it’s the 

end for the entire line. Rather than 

launching a new 13-inch MacBook 

Air, Apple released a cheaper, 

feature-limited version of the 13-inch 

MacBook Pro instead. Apple Senior 

VP Phil Schiller devoted significant 
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time onstage to highlight how the 

new MacBook Pro is actually thinner, 

lighter, and less voluminous than the 

13-inch MacBook Air.

You can still buy a $1,000 13-inch 

MacBook Air on Apple’s website (go.

macworld.com/macbookair) for now, 

but don’t expect it to last forever. The 

MacBook Pro and $1,300-plus 

12-inch MacBook (go.macworld.

com/12inmacbook2016) are clearly 

the future for Apple’s laptops.

MACBOOKS WITHOUT  

RETINA DISPLAYS

And with the writing on the wall for 

the MacBook Air lineup, we’re 

finally moving beyond MacBooks 

with janky, subpar displays. No 

MacBook Air option even hit 1080p 

resolution.

Good riddance.

OPTICAL 

DRIVES

“But wait!” I hear 

you screaming. 

“Apple still sells a 

legacy non-Retina 

MacBook Pro, 

too!” No more, hypothetical, easily 

excited reader. Apple has discontin-

ued that as well, and with it goes the 

last MacBook with a built-in optical 

drive. Time to snag Apple’s USB 

SuperDrive (go.macworld.com/usbsu 

perdrive). (You’re going to need a 

USB-C adapter for that, too.) ■

7 TECHNOLOGIES KILLED IN THE NEW MACBOOK PROMACUSER

NO MACBOOK AIR 
OPTION EVEN HIT 
1080P RESOLUTION.
GOOD RIDDANCE.
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PASSTHROUGH POWER WAS initially rare for USB-C docks, which 

were designed to extend the single port on a 2015 and 2016 Mac-

Book. This was unfortunate, because a dock should be a way to get 

more out of a laptop without watching the battery drain. The Satechi 

Slim Aluminum Type-C Multi-Port Adapter ($60 on go.macworld.com/

satechislim) is part of a wave of docks that started to appear in 

mid-2016 that are both affordably priced and can make use of an 

Apple or a third-party USB-C charger while offering extensibility.

The Satechi is a neat combination of aesthetics and function. The 

rounded corners are nice for a unit you’ll drop into a bag, and the 

USB-C ADAPTER

SATECHI SLIM ALUMINUM TYPE-C MULTI- 

PORT ADAPTER: PORTABLE MACBOOK  

DOCK MAKES NO COMPROMISES
BY GLENN FLEISHMAN

Reviews MAC GEMS ARE APPS THAT OFFER 

STANDOUT UTILITY OR UNIQUE 

FEATURES AT A GREAT PRICE.

The Latest Mac Products 

Reviewed & Rated
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aluminum finish (available in four colors) can match or complement  

your Mac.

Utility matters, too. The built-in cable has reinforcement at the dock 

connection and the head. The USB-C jack is in an aluminum case for 

durability and stability, and it fits snugly into a MacBook. The cable itself 

has a heavy-duty flexible coating. All of that should combine to make it 

stand up well to wear and tear.

The dock has an HDMI port that supports 4K video at up to 30Hz 

using the DisplayPort standard. This is an odd aspect of USB-C, as 

support for the standard is built into the Mac and carried across the 

USB-C bus through dedicated channels, so the dock just has to get out 

of the way and route the signal appropriately. This one does so. (The 

port can support lower-resolution displays, too.)

I tested a newly erased external USB 3.0 solid-state drive with the 

dock’s USB 3 Type-A ports, and was able to get the maximum read (400 

REVIEWS  |  SATECHI TYPE-C MULTI-PORT ADAPTERMACUSER

SATECHI SLIM 

ALUMINUM TYPE-C 

MULTI-PORT 

ADAPTER WITH 

TYPE-C CHARGING 

PORT

mmmmm
AT A GLANCE

There’s a lot to like about the 
Satechi Slim Aluminum Type-C 
Multi-Port Adapter. It lets you 
charge or attach two USB 
devices and supports a 4K 
display.

PROS

cable

CONS

Type-A port

PRICE

$60

COMPANY

Satechi
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MBps) and write (300 MBps) speeds, even con-

nected to the 4K display, which can reduce the 

number of data lanes available on the USB bus.

The only downside to the dock is minor and 

didn’t come up in testing. Each Type-A port can 

provide no more than 1 amp (A) of power, and 

combined, the dock shouldn’t exceed 2A. The 

HDMI output and USB-C power passthrough don’t 

count against this. USB devices should “hand-

shake” with a port on a computer, dock, or hub to figure out how much 

power a device can obtain from the port. But Satechi says that a higher-

amperage USB device could try to pull more current than the dock can 

handle without shutting down. In testing, I didn’t see this even with a 

bus-powered SSD attached that formatted itself over several hours and 

an iPhone 6s charging via a Lightning cable. Some other docks I’ve 

tested seemed to shut down much more readily based on power pulls; 

that didn’t happen with the Satechi.

BOTTOM LINE

There’s a lot to like about the Satechi Slim Aluminum Type-C Multi-Port 

Adapter, including the price. At $60, it’s $20 less than Apple’s less 

robust and less capable USB-C Digital AV Multiport adapter (go.mac-

world.com/appleusbcport), which has an awkward dongle shape and 

one fewer USB 3 Type-A port. If you just want to be able to charge or 

attach two USB devices and have the option for up to a 4K display, the 

Satechi is an attractive pick. ■

THERE’S A LOT TO LIKE 
ABOUT THE SATECHI 
SLIM ALUMINUM TYPE-C 
MULTI-PORT ADAPTER, 
INCLUDING THE PRICE.
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DISK DRILL 3

mmmmh
AT A GLANCE

Disk Drill 3 resurrects data on 
more than 200 internal or 
external media types 
regardless of what file systems 
they use, and it now includes 
recovery for iOS and Android 
devices as well.

PROS

Mac, iOS, Android

monitoring

current macOS aesthetic

CONS

slow on larger capacity 
devices

COMPANY

Cleverfiles

EARLIER THIS YEAR I reviewed Disk Drill 2 (go.macworld.com/

diskdrillpro2rev), a highly recommended utility for recovering data 

from any storage volume attached to your Mac, regardless of which 

file system it was created with. While the software exceeded 

expectations in terms of functionality, it was sorely lacking in visual 

flourish, with a user interface that seemed out of step with the 

current operating system.

I’m happy to announce this grievance has been addressed with 

the new Disk Drill 3 (cleverfiles.com), which not only sports a much-

DISK UTILITY

DISK DRILL 3: MAC UTILITY  
NOW RECOVERS DATA FROM  
iOS DEVICES, TOO
BY J.R. BOOKWALTER

MACUSER
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needed fresh coat of digital paint but also nicely spices up the existing 

buffet of tools.

iOS-FRIENDLY

Like previous versions, Disk Drill 3 offers data recovery as a free down-

load, which includes a handful of tools for monitoring disk health, 

identifying and removing unwanted files, performing data backups, and 

more. There’s also full support for macOS Sierra 10.12 (it works with OS X 

Mountain Lion 10.8.5 or later), including the ability to create a bootable 

USB recovery drive in a few clicks.

Disk Drill 3 adds the ability to recover data from an iPhone, iPad, or 

iPod touch, which is handy when an iOS update fails without a current 

backup available or an older device stops working because of water or 

other physical damage. It works the same: plug in the iOS device, click 

Recover, then select Camera Roll photos, videos, contacts, calendar, 

Voice Memo recordings, Notes, bookmarks, Messages chats, or call 

history data to resurrect. (Android devices are also supported when 

NEW IN DISK DRILL 3 is the 

ability to recover data 

from iOS devices, but it’s a 

time-consuming process 

without an existing iTunes 

backup.
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rooted or in USB mass storage mode.)

There is some sleight of hand involved, however. In the absence of an 

iTunes backup, Disk Drill 3 first creates one, a time-consuming process 

for those of us with larger capacity devices. My 128GB iPhone 6s Plus 

was about 80 percent full and took several hours to scan before recov-

ery could take place. Judging from status updates, a lot of unnecessary 

time was spent scanning my entire iCloud Photo Library; a better solu-

tion would be an option to skip this content entirely, since it’s already 

backed up in the cloud.

The resulting backup doesn’t appear alongside others created in 
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RECOVERING FROM AN iOS 

device is largely the same 

as doing so from any other 

volume—select the desired 

data and click Recover to 

copy it to your Mac.
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iTunes. Instead, it’s tucked away in the user’s Library, temporarily con-

suming valuable space on your system drive. Although the actual 

recovery happens quickly, I’d recommend importing an existing iTunes 

backup to expedite the process. (There’s no support for recovery from 

iCloud backups, but this feature is in the works.)

MORE SPEED, SUPPORT

Although Disk Drill 3 won’t win awards for the iOS recovery speed, in 

almost every other regard, the software is faster than previous versions, 

and works harder at discovering files for recovery—up to 30 percent 

more, according to the developer. Byte-to-byte disk backups were 

quicker, as was mounting scan results as a disk image on the desktop, a 

handy feature that no longer requires the creaky old FUSE to be 

installed.

Disk Drill bulks up on support for native file systems (ExFAT, EXT4) 

and file signatures (Evernote XML notes, rich text documents, and others 

have been added). There’s also a new module to find and eliminate 

duplicate files, which worked quite well in my tests.

Last but not least, Disk Drill 3 offers a fresh new user interface, which 

now hides system partitions by default for a cleaner look and feel. 

There’s also a preference setting that offers more control over which 

THE FREE VERSION of Disk 

Drill 3 digs up 30 percent 

more files for recovery than 

previous releases.
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disk types appear in the main view.

While the free version tackles the basics for most users, an $89 Pro 

upgrade allows a single user to run Disk Drill 3 on up to three Macs, 

adding a more comprehensive Deep Scan, the ability to search lost 

partitions, and rebuild catalogs on unmounted HFS+ formatted drives. 

BOTTOM LINE

Disk Drill 3 again delivers the goods, and this time awesome data 

recovery tools are backed up by good looks and a more intuitive user 

interface. ■

REVIEWS  |  DISK DRILL 3MACUSER

DISK DRILL 3 also includes the 

ability to scan for duplicate 

files lurking inside folders on 

your Mac.
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FONTAGENT 7

mmmmh
AT A GLANCE

FontAgent 7 is full of useful 
new features, including an 
updated interface, new font 
previews, and a dramatically 
improved font identification 
engine.

PROS

world-class font identification

CONS

fonts

sets

FOR A NUMBER OF YEARS, the options for professional font- 

management utilities have been three: Extensis’s Suitcase Fusion, 

Monotype’s FontExplorer X Pro, and Insider Software’s FontAgent 

Pro (now simply FontAgent). Each caters to a different type (pun 

intended) of user, and FontAgent 7 (go.macworld.com/fontagent7) 

seems squarely aimed at users who need to manage a sizable 

collection of fonts but don’t want to worry about lots of details. It also 

makes sharing a font collection among multiple Macs or members of 

FONT MANAGER

FONTAGENT 7 AND FONTAGENT 

SYNC: ALL-NEW INTERFACE AND 

FONT SYNCING ACROSS USERS 

AND MACS
BY JAY J. NELSON
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a workgroup very simple.

New to FontAgent 7 is an updated interface, new font previews, a 

dramatically improved font identification engine that eliminates the need 

for dedicated FontAgent libraries, auto-activation plug-ins for the latest 

design apps from Adobe and Quark, and a new way to share fonts.

NEW INTERFACE

FontAgent 7’s most obvious improvement is the new interface, which 

lets you use one, two, or three panels. The left panel shows your font 

Sets and lets you select one and view its content in the center panel. 

The center panel lets you switch between a Table view, with its sortable 

columns of data about your fonts, and a List view, which shows fonts in 

their native typefaces with metadata about each font.

The bottom part of the center panel provides three view options:

REVIEWS  |  FONTAGENT 7 AND FONTAGENT SYNCMACUSER

THIS IS FONTAGENT 7’s three-

panel interface, with the 

center panel in List view. 

The Status field at the top 

displays my last operation, 

which was to delete a Smart 

Set. The right panel displays 

all the information that can 

be known about a selected 

font or font Set. 
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> Player view plays a slideshow of your selected fonts in custom text 

and colors.

> Compare view lists your selected fonts in custom text and colors.

> Glyph view lets you view individual character glyphs and drag them 

into your documents.

Buttons across the top let you control the view options, activate and 

deactivate fonts, and share and synchronize font Sets with other users. 

A Status field at the top displays the most recent action you performed, 

such as importing or activating fonts.

SETS

When you’re looking for a specific kind of font, a Smart Set can help you 

find fonts that have shared attributes. For example, you may be looking 

for OpenType fonts with the word Pro in their name. Or perhaps you 

want to wrangle up every font with Futura in its name. A Smart Set can 

collect all your fonts with these attributes, and will update automatically 

when new fonts are added to your collection.

THIS IS FONTAGENT 7’s 

center panel in Table 

view, with Glyphs showing 

below. The drop-down 

menu at bottom left 

conveniently lets you 

choose a subset of the font 

to view.
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Also, FontAgent 

7 lets you tag any 

Set as a startup set, 

instead of letting 

you assign one Set 

for the fonts you 

always want to 

activate when your 

Mac starts up.

The subscription-

only Sync version 

of FontAgent 7 lets 

you share any set with your other Macs or other members of your 

workgroup. When you share a set, its content is uploaded to Insider’s 

servers and is automatically available in FontAgent 7 on other Internet-

connected Macs belonging to you or to your workgroup members. You 

specify your workgroup’s members at the Insider account dashboard.

Sadly, you can’t share a Smart Set, but you can create a regular Set 

from the content of a Smart Set and share that.

(Insider Software also offers a Connected Edition of FontAgent for 

larger organizations. It can use either a dedicated server in your organi-

zation or Insider’s cloud server, with tools to administer permissions for 

both Mac and Windows users.)

AUTO-ACTIVATION PLUG-INS

Plug-ins are included for Adobe InDesign, InCopy, Photoshop, and 

Illustrator CS3 through CC 2015, and QuarkXPress 5 through 2016. 

These plug-ins add a small bit of code to each document you open and 

save in these apps that lets FontAgent identify the exact fonts used in 

the document. When you re-open these documents, FontAgent can 

automatically activate those fonts.

Cleverly, when you first open a document whose fonts aren’t active, if 

FontAgent has several possible matching fonts it presents a Conflict 

Resolver window. Using 37 criteria to identify the font, it ranks the relevancy 

of each possible match to help you choose the correct font (including font 

foundry, format, and version). If you’ve ever had to blindly choose the 

“correct” font to activate, you’ll appreciate this powerful new feature.
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THIS SMART SET will find all 

my fonts in OpenType format 

from the P22 type foundry, 

that I’ve rated 3 stars or 

higher, and whose name 

includes Script. I haven’t 

decided on whether to also 

require that the font be 

activated, or include specific 

traits.
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MORE FONT SUPPORT FEATURES

Any fonts you’ve acquired from font rental services such as Adobe Typekit 

or Monotype SkyFonts are available for use in Sets in FontAgent 7.

FontAgent 7 includes more than 1,350 free Google fonts, any of which 

you can choose to install. As with everything that’s free, the value of 

these fonts is in the eye of the beholder.

FONTAGENT 7’S HELP system 

is comprehensive and, well, 

helpful.
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Using a font manager can be confusing and complex. Kudos to 

Insider’s team for making FontAgent 7’s Help system so useful.

FontAgent 7 is bundled with Smasher 3, a utility that can “smash” 

complex multi-font suitcases into files that contain just one font each. It 

also has a font cache cleaning feature that removes the error-prone font 

caches created by Apple, Adobe, Quark, and Microsoft as well as 

leftover CUPS Spool Files. It can be set to automatically run whenever 

you log out, shut down, or restart, or to run every day, week, or month. 

For users who frequently activate and deactivate fonts, this feature can 

eliminate some of the problems working with fonts, as well as problems 

printing or generating PDFs. Think of it as “an ounce of prevention.”

LICENSING

FontAgent 7 Sync is the first version to be available on a yearly subscrip-

tion basis (at $59 per year), and is required if you want to share font 

sets. The Standard single-user version is also available for a one-time 

$99 fee. Users of FontAgent 6 can upgrade to either version for $59.

BOTTOM LINE

FontAgent 7 is the 

easiest way to share 

fonts among multiple 

Macs or within a 

workgroup. Current 

FontAgent users will 

appreciate version 7’s 

greater accuracy in 

identifying fonts used 

in documents, Smart 

Sets that automati-

cally update, and the 

elimination of Librar-

ies. New users can 

feel confident that their fonts will import without duplicates, and in the 

location required by Apple in OS X El Capitan and macOS Sierra. ■

REVIEWS  |  FONTAGENT 7 AND FONTAGENT SYNCMACUSER

THE INCLUDED SMASHER utility can 

automatically clear font caches 

and CUPS Spool files manually or 

on a regular schedule.
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AUDITION CC 

2015.2

mmmm
AT A GLANCE

Adobe Audition CC is a 
professional audio 
application designed for 
filmmakers, podcasters,  
and others to create, mix, 
edit, and analyze sound  
for broadcast or online 
distribution.

PROS

consolidates most-used 
tools in one panel

first-time or novice 
customers

Cloud subscribers

CONS

other Creative Cloud 
applications

subscription

post-production than music 

virtual instruments)

COMPANY

adobe.com

ALTHOUGH MOST VIDEO editing software does a decent job with 

audio, there’s nothing like using a tool dedicated to manipulating 

sound. Back in the day, one of my favorites was Soundtrack Pro, 

which Apple initially offered as a standalone product as well as part 

of the Final Cut Studio bundle.

It was a great match—if a particular piece of audio in a timeline 

needed more finesse than Final Cut Pro was capable of, you could 

AUDIO

ADOBE AUDITION CC (2015.2): 
AUDIO EDITING BECOMES MORE 
USER-FRIENDLY
BY J.R. BOOKWALTER
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send a clip to Soundtrack Pro, make edits, then round-trip it right back. 

Unfortunately, Apple decommissioned Soundtrack Pro with the 2011 

debut of Final Cut Pro X.

Perhaps not-so coincidentally, that same year Adobe introduced 

Creative Cloud, taking the first baby steps away from individually pack-

aged software in favor of effectively renting a suite of productivity 

applications for one monthly price. But coming on the heels of filling the 

Soundtrack Pro gap with a port of its own popular Windows audio 

editing software, it was double blow for Mac video enthusiasts.

AUDITION TIME

Several years later, the furor over subscription-based software has 

mostly died down now that Microsoft and others have joined the fray, 

but there’s still no sign Apple ever intends to make good on a replace-

ment for Soundtrack Pro.

REVIEWS  |  ADOBE AUDITION CCMACUSER

ADOBE AUDITION CC packs a 

ton of audio editing expertise 

into a single application, and 

now it’s easier for first-time 

users.
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Instead, we have Logic Pro X (apple.com/logic-pro; $200 on the Mac 

App Store), which is geared more to musicians than post-production, or 

Adobe Audition CC, which costs $20 per month as a single-app sub-

scription, or $50 monthly as part of a bundle with other pro video and 

creative apps. (There are alternatives including free, open-source 

software like Audacity, but I’m strictly focusing on commercially-available 

products.)

Former Macworld editor Christopher Breen expertly detailed the first 

iteration of Adobe Audition CC (go.macworld.com/auditionccapp) in his 

exhaustive review three years ago (go.macworld.com/auditioncc), which 

praised the exhaustive depth of features while lamenting the then-con-

troversial subscription pricing.

Since then, Adobe has been steadily improving the application with 

annual updates and frequent bug fixes, adding Dolby Digital import/

export and dialogue normalization in 2014, along with remix, text-to-

speech, and match loudness tools last year. Earlier this year, Adobe 

debuted the awkwardly-named “2015.2” update with two major new 

features, which I’ll be focusing on in this review.

THE SPRING 2016 update to 

Adobe Audition CC includes 

a new panel called Essential 

Sound, which provides an 

easier way for novices to get 

acclimated to the software.
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ESSENTIAL SOUND

Despite offering a comprehensive arsenal of audio recording, mixing, 

editing, and repair tools, Adobe Audition CC has traditionally been 

daunting for first-time users. Like the company’s other pro video applica-

tions, the user interface is split across multiple panels, each with tabs 

providing additional functionality. If you were just getting started, it 

wasn’t the most user-friendly experience.

Adobe has remedied this 

situation with the introduction 

of yet another panel, Essential 

Sound, which consolidates the 

most commonly-used options in 

a single place. From here, 

novice users can balance audio 

for a more unified sound, clean 

up dialogue tracks by reducing 

noise, rumble, hiss, or high-

frequency sibilance (that 

annoying “ess” sound), and 

much more.

It’s super-easy to use: Select 

one or more tracks in a multi-

track project, then choose the 

type of mix you’re working 

on—Dialogue, Music, SFX, or 

Ambience. Each mix type 

includes only what’s relevant to 

that category, although there is 

some overlap such as Unify 

Loudness, a tool designed to 

keep audio clip levels balanced.

Essential Sound also incorpo-

rates unique music tools that 

allow audio editors to stretch or 

remix tracks to fit a specific 

length without affecting the 

overall pitch or tempo. Best of 

REVIEWS  |  ADOBE AUDITION CCMACUSER

ESSENTIAL SOUND CONSOLIDATES only the most-used tools for multitrack 

dialogue, music, sound effects, and ambience in a single place.
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all, professional users can configure custom settings in a few clicks, or 

close the panel to work the way they’re used to. Essential Sound doesn’t 

offer new tools, but rather a new way of working, and a level of simplicity 

sorely missing in earlier versions.

DIRECT EXPORT

The second new feature in Adobe Audition CC 2015.2 is also long 

overdue, considering it’s been available in other members of the 

Creative Cloud video lineup for some time. Rather than exporting a final 

audio mix and importing it into Premiere Pro CC for output, Audition CC 

users can now directly export entire projects (complete with video) in 

the same step.

This is made possible by a new Export with Adobe Media Encoder 

option in the File → Export menu. When summoned, Media Encoder CC 

launches (assuming it’s not already open), sharing available formats and 

presets with Audition. After clicking OK, the project is added to the 

Media Encoder queue, where it begins rendering automatically in the 

background.

If you’re juggling several projects at once or want to export variations 

with specific tracks isolated, Media Encoder allows you to continue 

working in Audition or Premiere Pro while rendering. It’s also easy to tell 

which projects originated in Audition, since the app’s icon appears next 

THE NEW EXPORT with Adobe 

Media Encoder option saves 

video editors from having to 

send mixes back to Premiere 

Pro CC.
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to the project name.

While Audition CC may not have received as much love in Adobe’s 

Spring 2016 update as sibling applications, the workflow improvements 

are definitely welcome.

BOTTOM LINE

Adobe Audition CC 2015.2 isn’t a revolutionary update, but the Essential 

Sound panel makes it more user-friendly for those getting started with it. ■

REVIEWS  |  ADOBE AUDITION CCMACUSER
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NONDA HUB+ MINI

If you have a 2015 (not 2016) MacBook, and you have a DisplayPort 

version of the Apple Cinema Display (models A1267 and A1316)—not 

the Thunderbolt version—then the Nonda Hub+ mini (nonda.co) fits 

your needs. If you want to drop $150. For that price, you get a nice little 

package of brushed aluminum, available in three finishes. It comes with 

a short, removable USB-C host cable that’s intentionally directional. 

One end (marked) fits into the dock very neatly and solidly; the other 

plugs as firmly into the MacBook as Apple’s own charging cable. With  

a two-display setup streaming 4K video from YouTube to the Apple 

Cinema Display, performance went off without a hitch. —GLENN FLEISHMAN



WACOM BAMBOO SLATE

The concept is simple: If you like to take notes by hand—with pen and 

paper—and you’re not above a few diagrams and doodles along the 

way, Wacom’s Bamboo Slate smartpad (us-store.wacom.com) might be 

the most optimal way to convert your notes from analog to digital. It 

comes in two sizes—10x12.9 inches (which costs $150) and 7.3x9.8 

inches ($130). Its companion pen has a traditional ink tip that is not a 

stylus, and it lets you jot down notes, upload them to the cloud, and edit 

and share them in various formats from your iOS devices. The Slate 

ships with a pad of paper, but when that’s done, you can use whatever 

pad of paper you want—no special paper required. —JACKIE DOVE

Hot Stuff

44

MACUSER
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ELGATO’S EVE HOMEKIT 

LIGHTSWITCH 

Smart light bulbs are a dime a dozen, but 

home device maker Elgato decided that 

another effective way to control your  

home lighting isn’t a bulb and hub or 

bridge set-up—it’s a smart light switch.  

The company’s new $50 Eve Light Switch 

(elgato.com) is the first HomeKit-compatible 

product of its kind, which means you can 

control your lights with just your voice. 

Thanks, Siri! The simple white Bluetooth 

wall plate replaces your standard single 

pole switch, which you can either swap out 

yourself or call in a professional. The best 

part is you can control your lights without 

outfitting your house with smart bulbs and a 

hub—though you can use the Eve switch to 

control those, too, if you already have Hue 

lighting installed. —CAITLIN MCGARRY 





iOS CENTRAL �e Latest on the iPhone, iPad, 
iPod Touch, and App Store

Photo shootout: We tested 
Portrait mode with an 
iPhone 7 Plus fashion shoot
Just for fun, we pushed Portrait mode to the limit and compared the 
results to a DSLR. The results made our photographer jealous.

BY SUSIE OCHS & ADAM PATRICK MURRAY

VIDEO

To view this video, 
go to go.

macworld.com/
ip7plusportvid
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iOS CENTRAL PHOTO SHOOTOUT: iPHONE 7 PLUS

T
he best camera is the one you have with you, the old 
cliché goes, and as we found in our experiment, if that 
camera happens to be an iPhone 7 Plus, you’re going to 
be just fine. The dual-lens camera system lets it take 

better photos than any smartphone we’ve tried, and the Portrait 
mode in iOS 10.1—which was just recently pushed out—is a lot of 
fun to play with.

Adam, our staff photographer, was 

incredibly eager to see what the 

iPhone 7 Plus could do, so we hired a 

model to re-create the kind of fashion 

photo shoot that he would normally 

do with his trusty Sony a7R II with a 

Canon 50mm lens.

We shot indoors in low lighting as 

well as full light, then took the show 

on the road for outdoor shots in a 

couple of locations near the office. 

Our model, Alina Lee (instagram.com/

ohthumbelina), did a wonderful job, 

and Adam came away more than a 

little impressed with what Portrait 

mode could do.

Now, we must note here that we 

tested Portrait mode while it was still 

in beta, and this isn’t a formal, scored 

review—just an experiment we did for 

fun. We wanted to see how Portrait 

mode (this first version of it, anyway) 

would react to different lighting 

conditions, and how its method of 

keeping your subject in focus while 

blurring the background would 

compare to a full-frame DSLR. Plus, 

Adam is a dedicated Android user, 

and he just wanted to see how far 

Apple has come with the iPhone 7 

Plus. Who could blame him, right? 

Check out some of the results here.

We started in low light, indoors 

(photo 1). This is barely enough light 

to trigger the depth effect—you’ll see 

a yellow Depth Effect label appear on 

the screen when you’re at the right 

distance and lighting level to make it 

work.

In this shot, we’re pushing the 

distance a little bit too—typically, 

Adam says, a portrait would be a little 

PHOTO 1

48



tighter on her face. Since Portrait 

mode uses the 6.6mm “telephoto” 

lens on the iPhone 7 Plus, which has 

an f/2.8 aperture and no optical 

image stabilization, you can see 

some noise, but all in all this isn’t too 

bad for an indoor photo.

Another low-light, indoor shot 

(photo 2) and we still get the depth 

effect. In the depth effect shot on the 

right, you can see how some of the 

fine pieces of hair around her head 

get completely blurred out, but the 

blur effect also smooths out some of 

the noise on her arms.

Again, we’re pushing what Portrait 

mode is intended to do—this isn’t 

enough light for the best result, but it 

still looks interesting. And since the 

mode defaults to keeping both the 

original and blurred versions of each 

photo, you really don’t have much to 

lose by experimenting.

For our next set of photos, we 

stayed indoors but cranked up the 

lighting. In this shot, Adam was once 

again experimenting with how far he 

could get from Alina and still get the 

depth effect (photo 3). It seems like 

we got the best results inside of 8 

feet, but it was possible to push it up 

to 12 feet and still get it to work. The 

blurring is pretty minimal in this 

image because she’s relatively close 

to the background.

Once we got close up (photo 4), 

we started to see how Portrait mode 

PHOTO 2

PHOTO 3

PHOTO 4
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works to isolate Alina’s face. In this 

image, you can see how her entire 

face is kept perfectly in focus, like it 

would be if you masked it in Photo-

shop, while her hair (seen on the left 

side of the photo) is immediately very 

blurred even right next to the face.

Taking this same shot with a DSLR, 

we wouldn’t expect her entire face to 

be in the same plane of focus. Her 

left eye, for example, and her nose 

are angled closer to the camera lens 

than her right eye, but the iPhone 7 

Plus keeps them in the same focus. 

The strap on her dress is even closer 

to the camera lens, but it’s blurred 

because the camera didn’t isolate it 

to stay sharp along with her face. It’s 

an interesting effect, just not what we 

would expect from a full-frame DSLR.

Then we went outside (photo 5), 

where we found an alley illuminated 

with beautiful afternoon light reflect-

ing off the windows of the building 

behind us, almost like we’d planned 

it that way.

In this shot, you can see Portrait 

mode having some problems with 

the very outer edges of Alina’s hair. 

(Sometimes you can control for that, 

if it’s less windy or you load up on 

hair products, but for this experiment, 

the flyaways are our friends.) It does 

OK with the larger pieces, and it’s 

understandable that it couldn’t 

isolate every strand.

The depth effect also blurs the 

texture of her shirt a little, and it’s 

slightly odd how the background is 

equally blurred right behind her as it 

is all the way back. With a DSLR, the 

amount of blur would increase as 

you approach the horizon. Adam 

says that a talented Photoshop user 

could reproduce this blur effect with 

software, but it’s pretty remarkable 

that the iPhone 7 Plus camera can do 

it for you, in real time as you’re taking 

the photo.

iOS CENTRAL PHOTO SHOOTOUT: iPHONE 7 PLUS

PHOTO 5

PHOTO 6
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During the shoot (photo 6), we 

started seeing a lens flare leaking in, 

but that actually lets us point out the 

way Portrait mode isolates just a 

person’s face and blurs everything 

else. In this image, the flare appears 

in the foreground, but since it doesn’t 

cross her face, Portrait mode still 

applies the blur effect.

In the next shot (photo 7), Adam 

managed to catch the flare across 

Alina’s face. On the right, you can 

really see how Portrait mode masks 

her face. The flare actually widens on 

the top of her head, then snaps back 

to its original shape as it crosses her 

face.

The blur on her shirt is pretty 

noticeable in this pair too. Since it’s 

just a texture, it’s not a big deal here, 

but another time when I used Portrait 

mode to photograph my husband 

wearing a San Francisco Giants 

sweatshirt, it was a little odd to see 

the type in the logo become harder 

to read.

In photo 8, Adam included a 

couple of distracting elements in the 

background—the speed limit sign in 

the alley along with a couple of guys 

drinking beer or something. Portrait 

mode did a great job keeping the 

focus on Alina. We like how the brick 

wall on the photo’s right side doesn’t 

blur out too much, and her hair looks 

great. But we did lose a little bit of 

sharpness in her clothes—check out 

the bit of zipper and the two snaps 

you can see on her jacket, for 

example.

Mostly we think of portraits (photo 

9) being taken in portrait orientation, 

but it’s worth mentioning that iOS 

10.1’s Portrait mode works in land-

scape orientation too. This is one of 

our favorite shots from the day.

While iOS 10 does support captur-

ing and exporting RAW images, 

PHOTO 7

PHOTO 8
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PHOTO 9

Apple’s own Camera app sticks with 

JPEGs as a rule. In fact, Adam 

noticed that the Portrait versions are 

about half the file size as the 

untouched photos, so the Camera 

app is already making all the deci-

sions about what data to keep and 

what to discard.

So it’s unlikely that we’ll see RAW 

support added to the Portrait mode 

iOS CENTRAL PHOTO SHOOTOUT: iPHONE 7 PLUS

LEFT: THIS IS a Portrait 

photo taken with the 

iPhone 7 Plus, then 

edited by Adam in 

Photoshop.
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anytime soon, but it sure would make 

Adam happy. He exported the 

Portrait photo and edited the JPEG to 

get the final result, but naturally, a 

JPEG is already compressed and 

doesn’t offer the editing flexibility 

that a RAW file would.

Sometimes, we found we liked the 

sharp image better than the depth 

effect version. This shot (photo 10) in 

front of the Bay Bridge is one of 

those times, but maybe we just don’t 

have the heart to blur out such a 

notable landmark.

Adam did some edits on the 

Portrait version of the bridge photo 

(photo 11), to attempt to bring some 

sharpness back to Alina’s sweater 

and the stitching on her jeans.

For a few images, Adam put an 

edited Portrait photo (photo 12) taken 

with the iPhone 7 Plus next to a 

photo taken with his Sony a7R II. 

Then we showed them to a bunch of 

people around the office and had 

them guess which was taken with the 

“real” camera and which was taken 

with the smartphone. Not everyone 

got it right!

This closeup in the alley (photo 13) 

is another one of our favorites, but 

since the background isn’t so far 

from the subject, the blurring effect is 

somewhat subtle. You can still notice 

the effect having trouble with the 

edges of her hair, and adding a little 

too much blur to the texture of her 

PHOTO 10

PHOTO 11

PHOTO 12

53



shirt, especially the collar.

But when Adam edited the Portrait 

mode version in Photoshop (photo 

14), he was able to get some of that 

texture back.

The pairing (photo 15) showing the 

edited Portrait mode photo on the 

left, and a similar shot taken with the 

Sony a7R on the right, impressed 

everyone we showed it to. In fact, 

even a fellow camera geek on our 

video team was fooled, identifying 

the iPhone 7 Plus shot as being 

taken by a DSLR. If you know to look 

at the fine flyaways around her head, 

you might get it right. But otherwise, 

these are delightfully close.

In the end, Adam admitted he’s 

more than a little jealous of the 

capabilities of the iPhone 7 Plus—

even with the Portrait mode in beta. 

It’s not perfect, and we are eager to 

see how Apple might improve it in 

future versions—now that the full 

release is out, we’ll be doing some 

follow-up testing. But just the fact 

that you can do this with a smart-

phone is incredibly cool. ■

iOS CENTRAL PHOTO SHOOTOUT: iPHONE 7 PLUS

PHOTO 13

PHOTO 14

PHOTO 15
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6 more ways 
to make the 
most of Mail 
for iOS 10
Customize the Mailboxes screen, 
tinker with iOS 10’s mail filter, pick new 
message-swipe options, and more.

BY BEN PATTERSON
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A
bout a year ago, we served up eight gotta-know tips 
(go.macworld.com/8iosmailtips) for iOS Mail users—
everything from how to change the size of your mes-
sage previews to how to dictate your mail messages.

Now, we’re back with six more ways 

to make the most of Mail for iPhone 

and iPad, including a couple of nifty 

tricks for iOS 10. For starters, we’ll 

show you how to tinker with the new 

mail filter, as well as how to tweak 

iOS 10’s threaded messages view. 

You’ll also learn how to customize 

the Mailboxes screen, pick your own 

message-swipe options, and more.

CUSTOMIZE YOUR SWIPE 

OPTIONS

You don’t have to settle for Flag, 

Mark As Read, and Trash as your 

only choices when swiping inbox 

messages to the left or right.

If you like, you can swap out one 

of your left- or right-swipe actions 

with Move Message (to file a mes-

sage into a new folder) or Archive 

(which lets you toss a message into 

your All Mail pile).

The Trash option isn’t listed under 

the Swipe Options setting (Settings → 

Mail → Swipe Options), but you can, 

in fact, move the Trash action from 

Swipe Left to Swipe Right.

The trick: if you have Archive 

Mailbox selected as your default for 

“discarding” a message (tap Mail, tap 

the name of your account in the 

iOS CENTRAL MAIL FOR iOS 10 TIPS

YOU CAN PICK Archive 

as one of your “swipe 

right” options in Mail 

for iOS. 
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Accounts section, then tap Accounts 

→ Advanced and choose your default 

action under the Move Discarded 

Messages Into heading), pick Archive 

as your Swipe Right option. When 

you do, Trash will (confusingly) 

appear when you swipe right, while 

Archive will be a swipe left option.

CHANGE YOUR DEFAULT 

MAIL ACCOUNT

Left to its own devices (no pun 

intended), iOS will generally pick 

iCloud as your default mail account. If 

your main mail account is something 

other than iCloud, there’s an easy 

way to pick a new default.

Tap Settings → Mail → Default 

Account, then pick a mail account. 

Once you do, the account you chose 

will be automatically selected in the 

From line of new messages.

To change accounts on the fly, you 

can always tap From within a new 

message to send it from a different 

account; doing so won’t change your 

default setting.

CHANGE THE WAY THREADED 

MESSAGES BEHAVE

Thanks to iOS 10, you no longer 

need to tap on individual messages 

within a mail conversation; instead, 

you can simply scroll through the 

entire discussion on one screen. You 

may have also noticed that, by 

default, threaded messages in iOS 10 

start with the earliest message at the 

top, while the most recent sits down 

at the bottom.

To make your mail conversations 

start with the latest message at the 

top of the thread, try this: tap Set-

IF YOUR PRIMARY email account is something other than iCloud, 

you can set that account as the default. 

IF YOU DON’T want the most recent message in a threaded mail 

conversation to appear at the bottom of a thread, try this setting.
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tings → Mail, scroll down to the 

Threading section, then tap Most 

Recent Message On Top.

CUSTOMIZE THE  

MAILBOXES SCREEN

If you back all the way up in the iOS 

Mail app, you’ll arrive at the Mail-

boxes screen, which displays the 

inboxes for all your mail accounts 

and lets you drill down into specific 

mail folders.

Sitting in the top corner of the 

Mailboxes screen is an inconspicu-

ous, easy-to-miss Edit button; tap it, 

and you’ll be able to customize the 

Mailboxes view to your heart’s content.

For example, you can add short-

cuts that’ll let you see all the inbox 

messages you’ve received today, or 

all your sent or trashed messages. 

Even better, you can tap Add Mailbox 

to pin any mail folder or subfolder to 

the Mailboxes screen.

Once you’ve added new shortcuts 

and folders to the Mailboxes view, 

you can rearrange them; just tap, 

hold, and drag the three-line handles 

to the right of each item.

CUSTOMIZE iOS 10’S  

NEW MAIL FILTER

The new mail filter in iOS 10 does a 

nice job of paring your inbox down to 

only unread messages, but if you like, 

you can refine the filter even further. 

You can set iOS 10’s new Mail filter 

to show you only messages with 

attachments, messages sent just to 

you, mail from your VIP’s, and more.

YOU CAN ALSO set the filter button to show just messages 

addressed to you, messages with attachments, or just 

messages from your VIP contacts. 

YOU CAN TAKE charge of the Mailboxes screen in the iOS Mail app once you tap 

the Edit button.
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Tap Filtered By next to the filter 

button and you’ll see a bevy of 

options, including mail accounts you 

want the filter to include or exclude 

and whether filtered mail should 

reveal flagged on unread messages.

USE DIFFERENT MAIL 

SIGNATURES FOR YOUR 

VARIOUS ACCOUNTS

Nope, you don’t have to use the 

standard Sent From My iPhone email 

signature for all your mail accounts. If 

you wish, you can customize your 

“sig files” for each account, putting 

(for example) your home phone 

number in your personal Gmail 

account and your office number and 

job title in your work account.

Tap Settings → Mail → Signature, then 

select the Per Account option. When 

you do, new signature fields will 

appear for each of your mail accounts.

BONUS TIP: Don’t forget, you can 

add formatting like bold, italic, and 

underline to your mail signatures. 

Just select the text you want to 

format, then tap the BIU button in 

the pop-up bubble. (You may have 

to tap the navigation arrows to find 

the right button.) ■

YOU CAN ADD 

customized signatures 

to each of your 

accounts in the Mail 

app for iPhone and 

iPad.
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Tim Cook: Augmented reality 
will be an essential part of 
your daily life, like the iPhone
“A significant portion of the population…will have AR experiences every day, 
almost like eating three meals a day.”

BY OSCAR RAYMUNDO
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Recently, Cook said that it will take 

some time for AR to become 

“acceptable.” But once that hap-

pens, AR experiences will be an 

integral part of our daily lives, 

comparing the emerging technology 

to the iPhone and eating three 

meals a day.

“I do think that a significant 

portion of the population of devel-

oped countries, and eventually all 

countries, will have AR experiences 

every day, almost like eating three 

meals a day. It will become that 

much a part of you,” Cook said 

during his panel at a tech confer-

ence in Utah (utahtechtour.com). 

Cook then admitted that there are 

technical challenges preventing AR 

from becoming a reality.

“AR is going to take a while, 

because there are some really hard 

technology challenges there,” he 

continued. “But it will happen, it will 

happen in a big way, and we will 

wonder when it does, how we ever 

iOS CENTRAL TIM COOK ON AUGMENTED REALITY

A
pple CEO Tim Cook has a hunch about the future of 
augmented reality, and whether it will ever become 
mainstream.

VIDEO

To view this video, 
go to go.

macworld.com/
ip7plusarvid
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lived without it. Like we wonder how 

we lived without our phone today.”

This is not the first time that Cook 

has talked about augmented reality. 

During Apple’s quarterly earnings call 

this summer, the CEO said that the 

company (go.macworld.com/appleq3 

2016) was “high on AR for the long 

run” and will continue investing in it. 

Cook seems more optimistic about 

AR becoming mainstream over virtual 

reality, however. While VR could 

bring interesting opportunities in the 

education and gaming realm, Cook 

doesn’t think it will be as acceptable 

as everyday AR experiences.

“I can’t imagine everyone in here 

getting in an enclosed VR experi-

ence while you’re sitting in here with 

me,” he said in Utah. Business Insider 

(go.macworld.com/tcookar) tran-

scribed Cook’s full comments on AR. 

You can watch his panel discussion 

(youtu.be/ZkV78RZ7 3Mw)—the AR 

topic comes up at the 18:40 mark.

Why this matters: Even though 

Cook does not think augmented 

reality will become mainstream any 

time soon, Apple has started taking 

baby steps in 

adopting the 

technology. 

Apple’s latest 

iPhone 7 Plus 

sports a dual-

camera system 

that could be 

used by devel-

opers to make 

AR experi-

ences, like 

Pokémon Go, a 

lot better. 

Eventually, 

the iPhone would need three or 

more cameras in order to be able to 

pull off the type of AR experiences 

that are being offered by Google’s 

Project Tango and Microsoft’s 

HoloLens. ■

“I DO THINK THAT A 
SIGNIFICANT PORTION 
OF THE POPULATION 
OF DEVELOPED 
COUNTRIES, AND 
EVENTUALLY ALL 
COUNTRIES, WILL 
HAVE AR EXPERIENCES 
EVERY DAY, ALMOST 
LIKE EATING THREE 
MEALS A DAY.”
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BLUETOOTH TRACKER

TRACKR BRAVO: IT’S LIKE FIND  

MY iPHONE FOR EVERYTHING 

ELSE YOU OWN
BY J.R. BOOKWALTER

FOR MY SON’S FIRST CHRISTMAS, his godfather gifted him a stuffed 

animal. Although the kid didn’t immediately fall in love with that floppy-

eared brown dog, within a few months the mutt we christened Biscuit 

became a more loyal companion than the family’s real-life canine.

Soon, the two of them were inseparable—together while shopping 

with Mommy, playing with friends, or as a passenger on cross-country 

road trips. My son was so devoted, my wife and I feared the day would 

come when Biscuit could be accidentally left behind. That was exactly 

what happened a few years ago during a fateful McDonald’s trip with 

grandpa. (He was found, but not before sufficiently terrifying the entire 

family.)

Nearly seven years later, Biscuit doesn’t travel as much as he used 

to, but my son still requires his mandatory presence every night at 

TRACKR BRAVO

mmmm
AT A GLANCE

TrackR Bravo is a slim, 

keychain-friendly disc made 

of lightweight, anodized 

aluminum that can be used to 

find lost or misplaced 

belongings with the help of a 

connected smartphone app.

PROS

•  Slim, lightweight Bluetooth 

LE tracking device

•  Two-way alerts

•  Crowdsourced GPS tracking

CONS

•  Device alert is shrill and not 

quite loud enough

•  Distance indicator isn’t 

always very accurate

•  Requires free TrackR Crowd 

GPS account

PRICE

$30

iOS CENTRALiOS CENTRAL

Reviews



bedtime. But we usually wind up 

searching for the scrappy little guy, 

who my son casually tosses aside and 

promptly forgets exactly where. That’s 

not much of an issue these days, 

thanks to a small gadget attached to 

his collar.

FIND MY (WHATEVER)

Measuring 31mm in diameter, TrackR 

Bravo ($30 on Amazon go.macworld.

com/trackrbravoamz) is a small, 

coin-sized disc made from anodized 

aluminum that can be attached to 

almost anything using the included 3M 

VHB adhesive or key ring. Available in 

four different colors, the device uses 

Bluetooth 4.0 LE (Low Energy) to 

connect to a smartphone app that 

allows users to find lost items within a 

100-foot range; up to ten devices can 

be tracked at once.

It’s a lot like Apple’s Find My 

iPhone, but Bravo is a whole lot more 

versatile since it can be attached to 

anything: keychains, backpacks, 

laptops, bikes, remote controls, or 

even the family pet (real or stuffed). At 

only 3.5mm thick, the device is slim 

enough to slip into most wallets, 

assuring you’ll literally never again 

leave money on the table.

For those who habitually leave things behind, the app includes the 

option of enabling separation alerts, which trigger an audible notification 

whenever your phone and the paired Bravo become too far apart. Alerts 

works both ways: the app can be used to find the device, or to ring the 

iPhone instead by pressing the lone button on the device.

REVIEWS  |  TRACKR BRAVOiOS CENTRAL

A FREE SMARTPHONE app 

connects to TrackR Bravo 

using Bluetooth LE so you’ll 

never lose or misplace items 

again.
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Bravo is powered by a CR1620 battery, which TrackR says lasts up to 

a year before needing a replacement. Thankfully, the process requires 

little more than inserting an unfolded paper clip into a small hole along 

the edge and prying out the battery. This requires a little more force than 

you might expect, but is easy enough for anyone to do.

LOST IN THE CROWD

Pairing TrackR Bravo with your iPhone 

or Android smartphone is a snap, but 

you’ll first need to sign up for the free 

TrackR Crowd GPS service. This 

account casts a wider net when an 

item goes missing by enlisting owners 

of the company’s over 2.5 million 

devices to help find yours.

Crowdsourcing works by sending a 

notification when another TrackR user 

comes within 100 feet of any lost item. 

You also have the option of paying an 

extra $10 when placing an order to 

have a custom message laser 

engraved onto the back of the device. 

This can be anything from contact 

information to the name of your pet; 

Bravo’s stylish good looks actually 

make a great replacement name tag, 

especially since it weighs only a 

fraction of an ounce.

For those more interested in finding 

lost items around the house, the 

TrackR app displays a map of the 

surrounding area, along with guid-

ance on just how close you are to the 

selected Bravo. It wasn’t pinpoint-

accurate in my tests, but close 

enough to be helpful.

Although you can set custom alert 

THE APP INCLUDES a variety 

of icon categories, and 

each TrackR Bravo can be 

assigned a custom name for 

easy identification.
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sounds on the iPhone using songs from 

your iTunes library, the tiny Bravo 

speaker only emits a shrill crescendo 

up to 86dB in volume. It’s not nearly 

loud enough in noisy environments, but 

certainly stands out in the next room; a 

blue LED built into the button also 

blinks while the alarm is being trig-

gered for visual assistance.

BOTTOM LINE

TrackR Bravo is Find My iPhone for 

everything else you own—including a 

kid’s favorite stuffed animal—and 

GPS-based crowdsourcing adds a nice 

extra layer of protection for items 

misplaced away from home. ■

REVIEWS  |  TRACKR BRAVOiOS CENTRAL

UP TO 10 TrackR Bravos can be connected to a single iPhone, with individual 

settings for each.
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ENTERTAINMENT

REELGOOD: ONE APP, SO MANY 
STREAMING OR THEATRICAL 
MOVIES TO DISCOVER
BY J.R. BOOKWALTER

WHEN I WAS A KID, it didn’t take much to get me to the movies. A 

promising trailer or article in one of my favorite genre magazines, and 

my butt was in the seat. Flash-forward a few decades, my busy sched-

ule—and a decent home theater setup—means I’m far more selective 

about what I’ll pay good money to see on the big screen.

MOVIE TRACKER

Reelgood (free on the iTunes Store go.macworld.com/reelgoodapp) is 

an iPhone app designed with folks like me in mind. At launch, the 

REELGOOD

mmmm
AT A GLANCE

Reelgood makes it easy to 

find new movies to watch at 

the theater or on a wide 

variety of streaming services, 

complete with push 

notifications when titles in 

your Watchlist are released.

PROS

•  Keep track of theatrical or 

streaming movies from a 

single app

•  Push notifications when 

Wishlist movies are 

available

•  One-tap playback of 

purchased content in 

streaming apps

CONS

•  Discover, Watchlist tabs 

can’t be sorted by release 

date

•  No option to purchase 

movie tickets

•  Favors new and popular 

movies over classics
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Discover view populates with 

gorgeous full-color poster art 

from current and upcoming 

theatrical movies. With a tap, you 

can quickly add the ones you’re 

interested in to a Watchlist, or 

mark them already watched.

If you’d rather sit through a 

root canal than watch the 

Ghostbusters remake, you can 

also tap the upper left corner to 

banish titles you have no interest 

in seeing to your personal 

Phantom Zone. When a movie in 

your Watchlist finally hits the-

aters, Reelgood notifies you with 

a push notification, then helps 

find show times at the nearest 

multiplex.

In addition to artwork, movies 

are accompanied by a synopsis, 

cast and crew list, Rotten Toma-

toes score, and other data as 

well as a trailer, which can be 

played full-screen in HD within 

the app. Like many services 

today, Reelgood also acts as a 

self-contained social network for 

movie lovers, where community 

members can post reviews and 

see what friends are up to.

Speaking of social, a Face-

book account is the fastest way 

to get up and running with 

Reelgood, but it’s not required. 

You can also create an account 

using an existing email address.

REVIEWS  |  REELGOODiOS CENTRAL

BROWSE CURRENT, UPCOMING, or classic movies with Reelgood, then add the ones 

you want to see to a Watchlist to be notified when they’re available.
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NOW STREAMING

Reelgood remains useful long 

after a movie has cashed in or 

bombed at the box office. Users 

can filter out everything except 

what’s available to watch from 

legal streaming services, includ-

ing Amazon, Hulu, iTunes, 

Netflix, VUDU, YouTube, and 

cable providers like HBO Now or 

Showtime.

After making a selection, the 

detail page offers a list of 

preferred services (selected at 

first login) in place of show times. 

Stores specializing in digital 

rentals or purchases appear with 

current HD prices for comparison 

shopping; a tap on the logo 

opens the corresponding app, 

although only iTunes allows 

direct purchases. Buying from 

other services must be done 

from a web browser.

These buttons are also a great 

way to rediscover digital movies 

you already own. Tap the desired 

logo, and Reelgood launches 

that provider’s app, where the 

selected title immediately begins 

playing. The same trick works for 

subscription-based services like 

Hulu as well.

My only real complaint is 

there’s no way to sort by release 

date; this would be particularly 

useful in Watchlist, for viewing 

MOVIES STILL IN theaters will display show times at your local multiplex, but there’s 

no way to actually buy tickets.
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current movies first, rather than 

having the list in alphabetical order 

or by date added. Also missing is the 

ability to purchase tickets inside the 

app. You’ll still need Fandango or 

another service for that.

BOTTOM LINE

Reelgood makes it a snap to find a 

movie at your local theater or favorite 

streaming service. But tickets and 

digital purchases other than iTunes 

must be done elsewhere. ■

REVIEWS  |  REELGOODiOS CENTRAL

REELGOOD’S WATCHLIST TAB shows everything you’ve seen or are interested in 

seeing, but oddly movies can’t be sorted by release date.
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What’s new  

at the App Store

LIP SYNC BATTLE
Lip Sync Battle (spikeslipsyncbattle.

com)—the show spun off from 

Jimmy Fallon’s “Tonight Show” 

gimmick—is now available in 

freemium app form for iPhone and 

iPad. Choose your favorite songs, 

add SnapChat-style masks if you 

like, then lip sync to the music. You 

can add effects and filters after-

ward, then share with your friends. 
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Findo
Findo (freemium; iPhone and iMessage; 

findo.com) searches for your emails, 

files, images, and notes in Gmail, 

Google Drive, Dropbox, Evernote, 

Outlook, OneDrive, Yahoo Mail, and more. You can 

find those files without leaving Slack, Facebook 

Messenger, Telegram or Skype—and when the right 

item is found, you can immediately share it within 

your messenger platform of choice.

Blinq
Blinq ($1; iPhone and Apple Watch; 

hologramdesign.co/blinq) is billed as 

“easiest, quickest and most intuitive way 

to keep track of your finances.” The app 

makes it easy for you to enter expenses, helps you 

learn about your spending patterns, and alerts you if 

you’re about to go above your budget.

Tinkerblocks
There are a number of apps created 

in the last year that combine game-

play with teaching kids how to code. 

Tinkerblocks ($3; go.macworld.com/

tinkerblocks) is another one. The idea? To have 

fun while learning the basics about how to create 

and execute commands, parameters, functions, 

loops, conditions, types, and bug-fixing.

Chartistic
Chartistic (free, iPhone only; go.mac-

world.com/chartistic) lets you create 

and edit interactive bar charts, line charts, 

area charts, and pie charts for use in 

presentations, both in the boardroom and the class-

room. Once you’ve created the chart, you can export 

it for use in emails, documents, spreadsheets, and 

social media. —JOEL MATHIS
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BY JOEL MATHIS 

iOS Accessories
This month's roundup of iOS accessories includes a wireless smart 
thermometer, vritual keys, glucose meter, noise cancelling headphones 
and solar charger. 
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DARIO
Since previous iterations of this 

device used the iPhone’s 

headphone jack to help 

measure blood sugar, the Dario 

Glucose Monitoring System for 

iPhone 7 (mydario.com; $40 

MSRP) is having to adapt. The 

new pocket-sized glucose 

meter will now be compatible 

with the phone’s Lightning jack. 

It ships in the first quarter  

of 2017.

SEN.SE
The ThermoPeanut (sen.

se; $29 MSRP, same price 

on Amazon) is a “smart 

wireless thermometer”—

place one in every room 

where you want to 

monitor the temperature, 

and the device will relay 

that info to your phone via 

Bluetooth. If a room gets 

too hot or cold, you’ll 

receive alerts on your 

phone. 
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MUJJO
Winter’s on the way! That means it’s time for 

this company to unveil its annual Touchscreen 

Gloves Collection (mujjo.com; $23 to $93 

MSRP), fleece-lined gloves that let you oper-

ate your iOS device outside in the freezing air 

without having to get your hands cold. The 

gloves come in a number of styles, including 

leather and wool, and in single- and double-

layered varieties.

BITEMYAPPLE
Solar Paper (bitemyapple.co; $200 

MSRP, $124.62 on Amazon) is billed 

as “the world’s smallest solar charger 

for the amount of potential wattage it 

can generate.” The makers say it can 

recharge your iPhone in 2.5 hours on 

a sunny day. And the system is 

expandable; strong magnets mean 

you can string together a series of 

Solar Paper panels to generate even 

more backup power.
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BESOUND
The Thunder (igg.me/at/thunder-the-earphones;  

$149 MSRP through Indiegogo) noise-cancelling 

Lightning headphones are popular—the product  

has quintupled its crowdsourcing goal with two 

weeks left to go during its fund-raising period. Why? 

Maybe because it promises “powerful noise cancel-

lation” without using too much power: Just 1 percent 

of a battery’s reserves per hour, “meaning you can 

kick back and relax and not worry about battery 

levels.”

DOG AND BONE 
CASES
The Locksmart Mini (dogandbon-

ecases.com; $69.95 MSRP) ditches 

keys and combination codes entirely, 

relying on your iPhone to unlock 

access to your precious valuables. 

Better yet, you can choose to share 

the virtual keys to your locks with 

friends and family, or to take them 

away. The lock is available in black, 

blue, and red.
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HANDS-ON: 

APPLE’S NEWEST MAC PACKS A STRIP OF iOS-STYLE CONTEXTUAL  

CONTROLS INTO THE TOUCH BAR. THERE’S ALSO A NEW KEYBOARD  

AND FOUR THUNDERBOLT 3 PORTS. BY SUSIE OCHS
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t’s thinner, lighter, and smaller all around, but the 

new MacBook Pro (go.macworld.com/buymac 

bookpro) makes a big impression. The trackpad on 

the 15-inch version is downright ridiculous—twice as 

large as the trackpad on the previous generation—but I 

didn’t look down and say, “Holy cow, that is a seriously huge 

trackpad,” until I’d been using it for a couple of minutes.

Because it’s really all about that gorgeous Touch Bar.

FEATURE    H A N DS O N: TH E N E W M ACBOO K PROS



THE TOUCH BAR changes 

based on what you’re 

doing, including 

predictive controls in 

some apps. 

Apple doesn’t do touchscreen 

Macs, but the Touch Bar adds a strip 

of ultra-handy iOS-style contextual 

controls right where you need them, 

and the rest of the MacBook Pro got 

great updates too. After my limited 

hands-on time, I think it’s got the right 

mix of power, portability, and ports to 

satisfy users of previous MacBook 

Pro and MacBook Air models. Let’s 

dive right into my first impressions.

TOUCH BAR
The Touch Bar, which replaces the 

row of Fn keys on top of the Mac-

Book Pro’s keyboard, enables new 

functionality like Touch ID to unlock 

the Mac and make Apple Pay pur-

chases in Safari without needing to 

authenticate with an iPhone or Apple 

Watch. It’s made of smooth glass, so 

it feels great under your fingers, just 

like the trackpad itself.

The Touch Bar supports Multi-

Touch, in case you need to tap or 

slide on more than one control at 

once. This would come in handy in 

some apps, like djay Pro, but since 

the bar isn’t really tall enough for 

common multi-finger gestures like 

pinch-to-zoom, I was content to poke 

at it one finger at a time.

I love how you can customize the 

Touch Bar’s default controls. Just 

pick View → Customize Touch Bar 

from the Finder menu, and you get a 

full suite of buttons you can drag 

right down to the Touch Bar. The 
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options are similar to what you see 

when customizing the toolbar in your 

Finder windows.

But the coolest part of the Touch 

Bar is how quickly it changes as you 

switch apps. I used it for scrolling 

through a full-screen album in 

Photos, as well as for scrubbing 

through the timeline in Final Cut Pro. 

Both were fast and responsive.

However, when I opened a new 

Mail message and started typing, the 

QuickType suggestions shown in the 

Touch Bar lagged behind my fingers. 

I had to consciously slow down to be 

able to see the predictions and 

select them from the Touch Bar, so it 

was faster to just type the entire 

word with my fingers. Happily, pulling 

up the scrolling emoji menu in 

Messages and choosing an emoji 

from the Touch Bar is a million times 

faster than pressing Command-Con-

trol-Space and using the Characters 

menu, like I have to do on my Mac-

Book Air today.

The other killer Touch Bar feature 

might be predictive suggestions in 

Mail. When you’re looking at a list of 

messages in your Inbox, you’ll see a 

button on the Touch Bar that says 

Move To Vacations or the name of 

FEATURE    H A N DS O N: TH E N E W M ACBOO K PROS
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another folder the app thinks is 

suitable. Mail seems to be guessing 

based on context, such as the 

sender and content of the message, 

and I can’t wait to see how well it 

does with the volume of email I get 

every day.

THE NEW KEYBOARD
The new MacBook Pro models have 

a low-travel keyboard similar to the 

12-inch MacBook, but Apple says it 

uses a second-generation butterfly 

mechanism to give the keys a better 

feel. They don’t seem to travel 

physically further. Apple says it just 

used slightly different materials for a 

different feel under your fingers. No 

haptics in the keyboard.

The keys feel about the same to 

me as they did on the MacBook. 

They don’t wiggle back and forth if 

you happen to strike one off-center, 

and they make a deep clicking 

sound when you pound on them. 

But when I switched back to my 

trusty 2013 MacBook Air to write this 

hands-on, my fingers immediately 

preferred the bouncier mechanism 

of Apple’s old laptop keys. I’ve never 

had trouble with the MacBook 

keyboard, and I’m sure I’ll get used 

to this one too, but I do like the old 

kind better.

JUST LOOK at the size 

of that trackpad. (This 

is the 15-inch model.) 
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PORTS ON  
BOTH SIDES
If you were worried Apple would ditch 

the headphone jack on the MacBook 

Pro, you can exhale now. (After all, 

Apple did ask its customers a while 

back if they were using it!) Every 

MacBook Pro model has a headphone 

jack on the right-hand edge.

You also get four Thunderbolt 3 

ports on the 13-inch and 15-inch 

models (only two on the lower-end 

13-inch MacBook Pro with Function 

Keys, but we’re discussing the Touch 

Bar models here). Apple put two on 

each side, and it’s kind of cool how 

all the ports can charge the laptop or 

connect to Thunderbolt, DisplayPort 

1.2, and USB-C devices.

I’m used to having dedicated ports 

for each IO method, so the flexibility 

is appreciated, and it’s a relief Apple 

went with four instead of, say, two. 

You’ll still need adapters for some 

things, like peripherals that use 

USB-A or Thunderbolt 2 ports, or an 

SD card reader, since that slot is 

gone. But having multiple ports might 

let you avoid picking up one of the 

USB-C docks that MacBook owners 

need if they want to connect more 

than one device at a time.

ONLY FIRST 
IMPRESSIONS
The beautiful Retina screen is 

unchanged from that of previous 

generations, and with the new Mac 

lineup, every notebook Apple sells is 

now Retina. In our full review we’ll 

dive more deeply into the perfor-

mance of the updated processors and 

GPU, as well as Apple’s promised 

10-hour battery life. But from what I’ve 

seen so far, the updated MacBook Pro 

is going to be worth the wait. ■
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DON’T EVER 

leave us, 

audio port. 
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iPHONE 7 PLUS REVIEW: 

THE DUAL-LENS CAMERA 
MAKES IT A WINNER

Previously, a Plus-sized 
iPhone meant a bigger 
screen and that was about 
it. With the iPhone 7 Plus, 
the dual-lens camera is a 
major selling point.

BY SUSIE OCHS
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T
he iPhone 7 Plus (go.macworld.com/

iphone7plus) is the best iPhone money 

can buy, hands down. Like the iPhone 7, 

it’s not an essential upgrade if you have 

an iPhone 6s Plus that you’re happy 

with, or you want to hold out for the 2017 iPhone, 

which will be the 10th anniversary one and, rumor 

has it, the big switch to OLED (go.macworld.com/

iphone8rumors). But thanks to the iPhone 7 Plus’s 

beautiful screen, long battery life, and impressive 

dual-lens camera, it’s hard to find fault with it today.



Hard, but not impossible: The 7 

Plus has the exact same issues that I 

complained about in my iPhone 7 

review (to review: the new Home 

button and the missing headphone 

jack), so I won’t repeat myself here. 

Except, I will say that a couple weeks 

later, I’m still not used to the fused 

Home button, with its odd-feeling 

ka-thunk sensation when I tap it, 

instead of a crisper click of the old 

Home button.

But the iPhone 7 Plus just has 

more going for it—the battery lasts 

longer, and that dual-lens camera 

delivers impressive photos, with the 

still-in-beta Portrait mode acting as 

icing on the cake.

SO BIG AND SO FAST
The screen is terrific, nice and bright, 

much easier to see in bright daylight 

than before. The speakers get 

suitably loud, making this a totally 

THE JET BLACK color picks up 

fingerprints, but it’s so pretty I 

don’t even care. 
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iPHONE 7 PLUS, 

256GB

mmmmh
AT A GLANCE

The iPhone 7 Plus’s 
dual-lens camera and 
long battery life give  
it the edge over the 
iPhone 7.

PROS

great photos.

any iPhone.

CONS

can’t charge and listen 
to wired headphones at 
the same time

PRICE

$969

COMPANY

Apple
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worthy mini-phablet for watching 

videos. I didn’t like how the speakers 

soundedv when I cranked music 

from Spotify, but they were fine for 

listening to podcasts while puttering 

around the kitchen.

I haven’t used a 5.5-inch iPhone 

on a regular basis before this one, 

and before the iPhone 7 launch I was 

very happy with the 4-inch iPhone 

SE. But now I’m slightly regretting 

going with the iPhone 7 over the 

iPhone 7 Plus. I like the smaller size 

when I’m carrying my iPhone, but 

when I’m actually using it, the iPhone 

7 Plus is just too sweet. After stretch-

ing out with a 5.5-inch screen, I was 

afraid the iPhone 7 and iPhone SE 

would seem like kids’ toys, but while 

the SE felt a little cramped by com-

parison, the iPhone 7 didn’t feel tiny 

compared to the 7 Plus.

Since they both have the A10 

Fusion chip, both the iPhone 7 Plus 

and iPhone 7 clocked similar scores 

in Geekbench 4’s CPU tests, with a 

slight edge for the 7 Plus. According 

to Geekbench 4, the 2.34GHz A10 

FEATURE     i PHO N E 7 PLUS RE V I E W
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Fusion in the new iPhones can even 

outperform my 2013 MacBook Air in 

the single-core test. Everything is fast 

on the iPhone 7 and 7 Plus, from 

running powerful image editors like 

Adobe Lightroom (go.macworld.com/

iphone7rev), to beautifully shaded 

games like CSR Racing 2 (go.mac 

world.com/csrracing2), to just 

installing a slew of updates from the 

App Store.

THE CAMERA IS 
SUPERB
I’m not a camera expert. I have never 

owned an SLR, and while I have a 

basic understanding of things like 

aperture, shutter speed, and focal 

length, I’m always going to want the 

camera to do the work for me. I just 

want to point and shoot and wind up 

with a great photo. The iPhone 7 Plus 

gives me really great photos.

Low-light photos are so much 

better than they used to be, since the 

Camera app can combine data from 

both lenses, the optical image 

stabilization helps keep things 

steady, and the wide-angle lens’s 

f/1.8 aperture lets in a lot more light 

than the f/2.2 lens in the iPhone 6s. 

(The telephoto lens has an f/2.8 

aperture.)

The new Portrait mode coming to 

iOS 10.1 is a great example of what 

the iPhone 7 Plus’s exclusive two-

lens camera system can do. Since 

this mode is still in beta (both the 

feature itself, and iOS 10.1, are in beta 

as of this writing), I didn’t factor it into 

the review score. But the biggest 

factor in choosing the 7 Plus over the 

iPhone 7 is the camera, and Portrait 

mode sells that better than anything.

As with the rest of the Camera 

app’s modes, Portrait aims to make 

NO CAMERA CAN keep a 

wiggly kid in focus, but 

this very amateur 

snapshot has nice 

colors and not-too-

terrible noise for being 

lit by a single lamp way 

across the room. 



things simple for the user. When you 

enable the mode, the view switches 

to the zoomed-in, 56mm-equivalent, 

6.6mm “telephoto” lens, and the 

camera will attempt to detect your 

subject, and then if the lighting condi-

tions are right, you’ll see a live 

preview that keeps your subject 

sharp while blurring the background 

with a lovely bokeh effect. A little 

label pops up on the screen to say 

Depth Effect so you know you’ve got 

it, and you’ll get a warning if there 

isn’t enough light. It works better 

outdoors—inside, the photos can get 

noisy if you don’t have plenty of light.

We’ll be posting separately the 

results of an experiment we did using 

the iPhone 7 Plus for a fashion shoot 

with a model, indoors and outdoors. 

The results were impressive (here’s a 

sneak peek), but again since this 

feature is in beta, Portrait mode’s 

performance doesn’t factor into the 

score of this review.

The iPhone 7 Plus’s Camera app 

also has a button above the shutter 

that toggles between a 1x and 2x 

view, or can be adjusted to any zoom 

level from 1x to 10x. You might assume 

that shooting at 1x uses the wide-

angle lens, while switching to 2x will 

FEATURE     i PHO N E 7 PLUS RE V I E W

POTRAIT MODE IS still in 

beta and didn’t affect 

the iPhone 7 Plus’s 

score. But we think 

it’s gonna be huge.
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use the telephoto lens, and going 

above 2x will use digital zoom. Well, 

that’s not exactly true. It turns out that 

the Camera app will use the wide-

angle lens and apply 2x digital zoom 

in some situations, if that would 

produce a better result (less noisy or 

shaky, or lit better) than using the 

telephoto lens. Glenn Fleishman dove 

deep (go.macworld.comiph7zoom) 

into this phenomenon, but I’m happy 

to let the Camera app make those 

decisions since all I want is a good 

photo. Third-party camera apps like 

Obscura Camera (go.macworld.com/

obscura) and Manual (go.macworld.

com/manualapp) let advanced 

shooters have more control, and can 

even export images in RAW.

BATTERY LIFE
I have a terrible time getting an 

iPhone to last all day, especially 

considering my usage is heaviest in 

the afternoon and evening. But the 

iPhone 7 Plus has a huge battery, 

2900mAh (11.1 watt-hours) according 

to iFixit’s teardown (go.macworld.com/

ifixitip7plustear) , and with savings in 

iOS 10, it can go a very long time.

I charged the iPhone 7 Plus up to 

100 percent, set it to 50 percent 

brightness and 50 percent volume, 

and played movies I’d previously 

downloaded from the iTunes Store to 

the Videos app until the iPhone 

reached 50 percent. That took a 

whopping 7 hours, 55 minutes on the 

iPhone 7 Plus, but the iPhone 7 only 

lagged behind it by a bit, clocking 7 

hours, 26 minutes.

Geekbench 3 also has a battery 

benchmark mode, and I used it to 

drain each iPhone from 100 to 80 

percent. For the iPhone 7, that took 1 

hour, 55 minutes, 8 seconds, for a 

Geekbench score of 1150. Running 

the same test on the iPhone 7 took 1 

hour, 42 min, 11 seconds, for a 

Geekbench score of 1021. That 

makes sense since the iPhone 7 

Plus’s battery is larger than the 

THE LARGER BATTERY in 

the iPhone 7 Plus 

provides more 

runtime than the 

iPhone 7, but maybe 

not as much more as 

you’d expect.
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people ask me to show them on the 

iPhone 7 Plus—being able to not just 

peek at emails and messages from 

your Notification Center, but actually 

archive an email or reply to a message 

change, is a time-saver, it’s true. But 

it’s also a much more natural gesture-

based way to navigate the iPhone 7 

Plus’s big screen with one hand.

Apple’s glossy new jet black color 

is really nice, and feels more secure 

in my hand than the aluminum-

backed models (rose gold, gold, 

silver, and matte black). It actually 

reminds me of my old unapologeti-

cally plastic pal the iPhone 5c, and I 

mean that as a compliment. After a 

couple weeks of use, I am seeing 

some very tiny scratches in the finish, 

mostly near the bottom corners, but I 

IF YOU CAN bear to 
cover the iPhone 7 
Plus, Apple’s $49 
Leather Case is 
appropriately luxe. 
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1960mAh (7.45 watt-hours) battery in 

the iPhone 7 (go.macworld.com/

ifixitip7tear).

So if you need more battery life, 

the iPhone 7 Plus is the longest-

lasting iPhone, but I was still sur-

prised that the iPhone 7 did so well 

matched up against it. Either way, 

you’ll probably have to charge your 

new iPhone on more or less the 

same schedule that you charged 

your old one.

THE LITTLE THINGS
Using the iPhone 7 Plus is a series of 

small delights. For example, while 3D 

Touch on the iPhone 6s felt more like 

a show-off trick than a useful feature, 

with iOS 10, it finally makes sense. 

Besides the camera, this is what 
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think Apple is being fair to call them 

“micro-abrasions” because I have to 

squint at the phone from an inch away 

to see them.

The jet black iPhone looks particu-

larly great without a case, but it does 

pick up fingerprints and smudges quite 

easily. (I never kept my trusty Toddy 

cloth (go.macworld.com/toddygear 

cloth) quite so close at hand—it’s 

brilliant at wiping away oil smudges 

rather than just smearing them 

around.) Apple sent over its $49 

iPhone 7 Plus Leather Case (go.

macworld.com/ip7plusleathercs), which 

has a very high-end feel. It has metal 

buttons for the volume and wake 

controls, which feel satisfyingly clicky 

to press while still blending into the 

case perfectly.

BOTTOM LINE
The iPhone 7 Plus has such a great 

camera that it’s easy to recommend it 

over the iPhone 7, and the extra dash 

of battery life is nice to have too. While 

it isn’t without its drawbacks, it’s got 

power, speed, and a shiny new coat. 

It’s a little mean that Apple doesn’t 

offer the jet black color at the lowest 

capacity (32GB) and price, but any of 

the iPhone 7 Plus models should make 

you a happy Apple fan. ■



  AMERICA,

 LET’S DO LUNCH TM
Julius Gaines, SINCE 1933. He’s got a curious intellect that can’t be satiated. 

Now, he and 1 in 6 seniors face the threat of hunger and millions more  

live in isolation. So pop by, drop off a hot meal and say a warm hello.  

Volunteer for Meals on Wheels at AmericaLetsDoLunch.org



WORKING MAC Tips, Tricks, and Tools to Make You 
and Your Mac More Productive

How switching to Macs is 
paying off for IBM
IBM employees prefer Macs, which is actually saving IBM about $543 per computer.

BY CAITLIN MCGARRY 
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WORKINGMAC IBM SWITCHING TO MACS

L
ast year, IBM made a bold decision. The company let its 
employees choose between a Windows PC or a Mac for 
their own work machines. IBM staffers prefer Macs, so the 
company bought up 30,000 of them. This year, IBM has 

90,000 Macs in use. But Macs are expensive, as we all know, so 
IBM must be spending a fortune on making the switch…right? 
Apparently not.

IBM said recently at the Jamf Nation 

User Conference that it’s actually 

saving money on each Mac: $273 to 

$543 per Mac over four years, 

compared to a 

Windows PC over the 

same time period. 

And no, that’s not 

because Microsoft is 

charging more. 

Fletcher Previn, IBM’s 

vice president of 

workplace as a 

service (yeah, that’s a 

real title), said 

Microsoft is giving 

IBM its best pricing 

ever. But Macs are 

still cheaper over 

their lifetime, and 

using them results in 

fewer service calls.

This is just one company’s data, but 

IBM expects to have more than 100,000 

Macs in use by the end of this year, so 

that’s a pretty significant sample size. 

The company is rolling out 1,300 Macs a 

week, and only five IT administrators 

are supporting all of those computers.

This shift is huge for Apple, which 

has struggled to find 

footing in enterprise 

computing. In 2014, 

the company inked a 

deal with IBM to 

develop mobile-first 

enterprise apps for a 

variety of industries, 

a move that has 

been incredibly 

successful. The 

alliance may seem 

like a strange one to 

those who remem-

ber the early PC era 

when IBM and Apple 

were rivals, but  

IBM doesn’t make 

Windows PCs anymore and has 

bolstered Apple’s enterprise pres-

ence. Clearly that move is paying  

off for IBM, too. ■

IN 2014, THE 
COMPANY 
INKED A DEAL 
WITH IBM 
TO DEVELOP 
MOBILE-FIRST 
ENTERPRISE 
APPS FOR A 
VARIETY OF 
INDUSTRIES, 
A MOVE THAT 
HAS BEEN 
INCREDIBLY 
SUCCESSFUL.
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PART 1

How to set up the Calendar 
Service in macOS Sierra Server
macOS Sierra’s Calendar support has robust features that may suit your needs.

BY JEFFERY BATTERSBY
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WORKINGMAC SET UP THE CALENDAR SERVICE

S
erver’s calendar service is one of my favorite features in 
the Server app and the one most likely to fly under your 
radar. This two-part series will help you set it up. When 
you think about hosted calendar services, your mind 

likely drifts to Google, iCloud, or Exchange. But the Server app’s 
calendar service offers more features than you may be aware of 
and gives you the benefit of keeping your business’ private 
calendar info secure and within the walls of your company.

In addition to the usual calendar fare, 

Server’s Calendar service lets you 

manage resource schedules (say, 

conference rooms and projectors), 

delegate calendar responsibilities to 

surrogates, offers automatic sched-

ule checking for all invited attendees, 

including resources, allows file 

attachments, private event annota-

tions, and uses Apple’s push notifica-

tion services to update events. In 

short, it’s a pretty robust hosted 

calendar that’s likely to fit most of 

your needs.

TURN ON THE CALENDAR 

SERVICE

As is the case with so many of 

Server’s features, the Calendar app 

is simple to get up and running.

1. Select the Calendar service in 

the sidebar of the Server app.

2. Turn the service on.

3. If you’re using an Apple AirPort 

in your network and you set Server 

up to configure your AirPort to allow 

access to your server’s services from 

the Internet, you may see a message 

asking if you want Server to config-

ure your AirPort. If you want access 

to your hosted calendar outside your 

network, click Allow. Otherwise click 

Don’t Allow.

That’s all that’s necessary to get 

the Calendar service started, so let’s 

see if it works.
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CONNECT TO YOUR 

CALENDAR SERVICE

Before you set up the calendar, you 

need to make a determination 

whether you want to access your 

calendar only from inside your 

private network or from anywhere on 

the Internet.

To access your server and calen-

dar data from the Internet, you need 

to know your external IP address or 

fully qualified domain name (FQDN). 

Inside your network, if you’re on the 

same subnet as your server, you don’t.

To find your external IP address:

1. Select your server in the sidebar 

of the Server app.

2. Click the Overview tab.

3. Locate the Internet section.

4. Make note of the IP address 

your server says services are reach-

able at.

To connect to your calendar:

1. Open System Preferences.

2. Select the Internet Accounts 

preference.

3. Click the + button at the bottom 

of the Internet Accounts preference.

4. Scroll down to the bottom of the 

list of pre-configured services and 

click Add Other Account.

5. Choose Server Account.”

6. Select your server from the list 

of available servers or click Other if 

you don’t see your server in the list 

or if you want to access your server 

over the Internet.

7. Enter a user name and password 

(you will also need to add an IP 

address or FQDN if you selected 

Other).

8. Select Calendars and Remind-

ers from the list of your server’s 

services.

9. Click Done.

10. Open the Calendar app and 

locate your server’s calendar in the 

list of calendars.

Now that you’re connected to your 

calendar, let’s create some resources 

and create an event.
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MANAGING RESOURCES

To create calendar resources:

1. Select the Calendar service in 

the sidebar of the Server app.

2. Click the + button below the 

Locations And Resources window.

3. Choose Location from the Type 

menu.

4. Give your room a name.

5. Add an address and note that a 

map of the location appears.

6. Leave Delegate blank. (We’ll talk 

about delegates in part 2.)

7. Select Accept If Free, Decline If 

Busy in the Scheduling field.

8. Leave Accept Group blank.

9. When you’ve entered all your 

information, click Create.

Next, create a new resource 

following the previous steps, but note 

that you don’t need a location for a 

resource.

CREATE AN EVENT WITH A 

RESOURCE

To create an event with your newly 

created resources:

SET UP THE CALENDAR SERVICE

1. Open the Calendar app.

2. Select your server’s calendar in 

the sidebar of the Calendar app.

3. Double-click a calendar date to 

create an event.

4. Give the event a name.

5. Click the Add Invitees field.

6. Begin typing the name of one of 

your two resources and a list should 

appear with the name of your 

resource.

7. Click the Check Availability 

button and confirm that you and the 

projector are available on the time 

and date you selected.

8. Click Done.

9. Click the Add Location field 

underneath your event name.

10. Begin typing the name of the 

location you created.

11. Select your room from the list.

12. When you’ve completed enter-

ing all your information, click Send.
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As soon as you click Send, your 

resource and room will accept your 

invite and be made unavailable to 

other users and your schedule will be 

blocked as unavailable for anyone who 

wants to schedule a meeting with you.

In part 2, we’ll spend more time 

with the Calendar service and look at 

how to delegate other users to 

manage your calendar and how to 

handle more complicated resource 

scheduling. ■
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PART 2

How to use the advanced 
Calendar Service features in 
macOS Sierra Server
Make adjustments to get the most out of macOS Server’s Calendar Service.

BY JEFFERY BATTERSBY

103



WORKINGMAC SET UP THE CALENDAR SERVICE

I
n the first part of this series, we took an initial look at setting 
up the Calendar service in macOS Server. Now we’ll look at  
some of the advanced features available to you within the 
Calendar service.

MANAGING RESOURCE 

ACCESS

The default scheduling behavior for 

resources is Accept If Free, Decline If 

Busy. Which makes perfect sense in 

most situations. But in some cases 

you may want to make someone 

responsible for managing access to 

resources, particularly if you have 

someone or some group responsible 

for the devices and rooms used for 

meetings.

In order to use this feature effec-

tively you’ll need to have Open 

Directory set up on your server, 

which is something we covered in 

our Primer on Profile Manager (go.

macworld.com/profilemanager) a few 

months ago. If you don’t already 

have Open Directory set up on your 

server, you’ll want to head over to 

that primer to learn how to get Open 

Directory going.

Once Open Directory is set up 

you’ll want to create a group to 

manage your AV resources. As to the 

“why” for a group? Putting users into 

a group for managing resources 

makes it easier to manage who will 

be notified when resource requests 

are made and will make sure you’re 

not the only one managing resource 

requests while you’re supposed to 

be vacationing in Barbados.

To set up the AV Room group:

1. Select Groups in the sidebar of 

the Server app.

2. Select Local Network Groups 

from the Groups menu.

3. Verify that Local Network 

Groups is unlocked for editing; if not, 

click the lock at the bottom of the 

Groups window and authenticate as 

the Directory Administrator.

4. Click the + button.

5. Create a new group named AV 

Room and click the OK button.

6. Double-click the AV Room 

group to edit it.

7. Open the Accounts Browser by 

pressing Command-B or by selecting 

Show Accounts Browser from the 

Server app’s Window menu.

8. Drag any accounts you want to 
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be a part of the AV Room group from 

the Accounts Browser to the AV 

Room’s Members window. You 

should not make the user you used 

to create an event (in part 1) a mem-

ber of this group.

9. Click OK.

Now that you have the AV Room 

group set up, let’s make them 

responsible for managing some 

resources.

DELEGATING RESOURCE 

RESPONSIBILITIES TO A 

GROUP

Select the Calendar service in the 

sidebar of the Server app and 

double-click one of the resources 

you created in part 1. The Delegate 

field should be blank and the Sched-

uling field should be set to Accept If 

Free, Decline If Busy.

1. Click in the Delegate field and 

begin typing the name of the AV 

Group.

2. Select the AV Group from the list 

of names that appears. Note: You can 

only add one group of individual 

users to this list.

3. Click the Scheduling menu and 

select Require Delegate Approval 

from the menu.

4. Click OK.

ADD A CALENDAR FOR  

YOUR DELEGATE AND 

SCHEDULE AN EVENT

Before you create an event with your 

newly delegated resource, you’ll 

need to add a calendar for one of the 

delegates to your Mac. Follow the 

steps in part 1 of this series to 

connect a new account to the 

Calendar service. Once you’ve 

added the account:

1. Open the Calendar app.

2. Open the Calendar menu and 

select Preferences.

3. Click the Accounts tab.
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4. Select your delegate’s in the list 

of accounts.

5. Click the account’s Delegation 

tab.

6. Put checks in the box next to 

each of the resources you want to 

see in your calendar.

7. Close the Calendar preference.

Once you’ve added the second 

account and made the delegated 

resources visible, create a new calen-

dar event using your updated 

resource.

1. Open the Calendar app.

2. Create a new event using the 

calendar for a user who is not one of 

your delegates.

3. If your updated resource was a 

location, add that location in the 

location field.

4. If your updated resource was a 

physical resource such as a projector 

or iPad cart, add that resource as an 

Invitee.

5. Click Send.

After a few minutes you should 

SET UP THE CALENDAR SERVICE

receive a push message in your 

delegate’s calendar requesting use 

of the resource.

1. Click the schedule notification at 

the top of the Calendar app.

2. Click the Accept button for the 

resource request.

Once you accept the request, all 

invitees for this event will see that 

the resource is now scheduled for 

use at your event.

BONUS DELEGATION

In addition to creating delegates for 

resources, you can also allow others 

to view and manage your calendar.

1. Open the Calendar app.

2. Click the Calendar menu.

3. Click Preferences.
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4. Select the Accounts tab.

5. Select the account you want to 

delegate access for.

6. Click the Delegation tab.

7. Click the Edit button.

8. Click the + button.

9. Begin typing the name of an 

Open Directory user you’ve created 

that you want to have access to your 

calendar.

10. By default any user you add will 

have read access to your calendar, 

put a check in the Allow Write check-

box for anyone you want to be able to 

make changes to your calendar.

As was the case with resources, 

every user you give access to your 

calendar will need to open their 

Calendar preferences, click the 

delegation tab, and put a check in 

the Show box in order to see your 

calendar. ■

107



How to bring back a physical 
Escape key on the new MacBook 
Pro with Touch Bar
No esc key? No problem. Just reassign its functionality to another key.

BY ROMAN LOYOLA

WORKINGMAC
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A
pple showcased its new MacBook Pro recently and 
demonstrated the new Touch Bar, an OLED touchbar 
across the top of the keyboard that replaces the 
function keys. The Touch Bar can be customized to 

suit the app that your Mac is currently running. The problem is 
that you may not have instant access to one of the most impor-
tant keys on your Mac: The Escape (esc) key.

The esc key isn’t completely gone. If 

the Touch Bar is in another mode, 

you can hold down the fn key on the 

lower left of the keyboard. That will 

make the function keys appear on 

the Touch Bar, and that includes an 

esc key.

Maybe that’s not good enough for 

you. Maybe you want a physical esc 

key you can access instantly. What 

you want to do is remap the Escape 

key to another key on your Mac. 

Here’s how.

1. Go to Apple menu → System 

Preferences, and click on Keyboard.

2. Click the Keyboard tab if it’s not 

active, and then click the Modifier 

Keys button on the lower right.

3. In the pop-up window that 

appears, select your keyboard from 

the “Select keyboard” pop-up menu 

at the top.

4. You’ll see a list of four keys: 

Caps Lock, Control, Option, and 

Command. You can reassign one of 

those keys to act as the Escape key. 

You may not want to select the 

Command key, since it’s frequently 

used for keyboard shortcuts. You 

may not want to use Control or 

Option, either, for the same reason. 

In my example, I’m reassigning the 

Caps Lock key to be my new Escape 

key.

5. Pick a key you want to reassign, 

then click on the pop-up menu to the 

right of that key, Select Escape.

6. Click OK. You can also quit 

System Preferences. ■
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To donate or volunteer, go to UNITEDWAY.ORG. 

BECAUSE GREAT THINGS HAPPEN WHEN WE LIVE UNITED.

Thanks to our work with NFL PLAY 60, we’ve brought fun fi tness programs 

to more than 35,000 kids. And it can happen here too.

WHAT THIS PLACE NEEDS
IS ACTIVE PLAY EVERY DAY.
WHAT THIS PLACE NEEDS

IS ACTIVE PLAY EVERY DAY.
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CREATE Using the Web for Video, Graphics, Publishing, 
Photography, and Other Creative Pursuits

Adobe Photoshop Elements 15 
review: Image editor boosts its 
photo-manipulation features
Brand-new guided edits make changing facial features, creating 
text from images, and making multi-textured collages a snap.

BY JACKIE DOVE



ADOBE PHOTOSHOP ELEMENTS 15 REVIEW

A
s smartphone cameras advance, offering features 
that rival and sometimes exceed the point-and-
shoots of old, hobbyist interest in photography has 
surged, not only for documenting friends and family, 

but for recording a critical world view—similar to classic street or 
landscape photography. When Apple posts billboards of scenes 
shot by amateurs and pros using their iPhone, it’s not hard to see 
where the inspiration comes from.

For those who want more visual tricks 

than Apple Photos offers (especially for 

composition and special effects) they 

turn to Adobe Photoshop Elements 

(go.macworld.com/elementsapp), an 

app designed for consumers who seek 

an easy way to achieve sophisticated 

special effects. Elements, now in its 

CREATE

PHOTOSHOP ELEMENTS 

ORGANIZER Smart Tag 

and visual search 

interface.

112



113

fifteenth iteration, is no Photoshop (go.

macworld.com/photoshopcc), but a 

good number of its advanced features 

are derived from the company’s 

flagship app and namesake.

Adobe is wise enough not to mess 

too much with the basic formula and 

general interface of this app, prefer-

ring to enhance and add to its 

features. With version 15, the 

updated Organizer companion rocks 

brand-new search capabilities and 

batch processing, while a new crop 

of guided edits refresh the main 

editing package.

ADOBE ELEMENTS 15 

ORGANIZER

The Adobe Elements Organizer, an 

analog to Photoshop’s Bridge, acts 

like a mini digital asset management 

system, keeping track of all photos 

and videos to make them accessible 

to the two main Elements apps, 

Photoshop Elements and Premiere 

Elements. Aside from import/export 

TYPE IN OR use Smart 

Tags to combine or 

exclude keywords in 

your search. 

and organizational functions like 

ratings and tags, the Organizer 

features face recognition, geo-tag-

ging, and built-in maps. The Orga-

nizer is also the place for basic fixes 

like rotation and auto-correction. In 

version 15, it does a lot more.

The Organizer now has more 

intelligent capabilities, like its new 

Smart Tags feature. From the search 

interface you can see exactly what 

tags the app has placed on your 

images. Google Photos, Flickr, and 

Apple Photos already use artificial 

intelligence to automatically deter-

mine content for tagging photos. 

Adobe says that deep learning 

algorithms were used to develop the 

Smart Tags feature, but that there is 

no on-going AI technology running in 

the Organizer.

You can use the app’s enhanced 

search functionality to quickly scroll 

by Smart Tags, People, Places, Date, 

Folders, Keywords, Albums, Ratings, 

and Media Types, whose icons run 
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down the left side of the window. You 

can choose from the icon or just type 

in search criteria in the box at the top 

of the window.

You can use the And or Or com-

mand to narrow down your search 

from thousands of images, video, 

audio, and projects to find the item 

you want. Note that each smart tag 

search builds on the previous one, so 

make sure the text box at the top 

reflects only your current search.

The Organizer’s new Instant Fix 

update now lets you batch-correct 

photos imported into the app. Just 

group together your chosen shots, 

and the new interface offers a set of 

adjustable sliders to fix them all 

simultaneously for clarity, color, light, 

brand-new special effects, and more.

PHOTOSHOP  

ELEMENTS EDITOR

Adobe’s famous Quick, Guided, and 

Expert editing modules lie at the heart 

of the Photoshop Elements Editor, 

making it the go-to app for amateurs 

seeking a more sophisticated but 

ADOBE PHOTOSHOP ELEMENTS 15 REVIEWCREATE

NEW BATCH PROCESSING in the Organizer.
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accessible alternative 

to Apple Photos. This 

new version debuts 

five new guided edits 

to perform complex 

tasks via step-by-step 

instructions. In this version, however, 

some were better than others.

Picture text

While it can be a fairly straightforward 

task to accomplish that beloved 

classical postcard effect of filling in 

lettering with a landscape or other 

images, you need the proper tools and 

know-how. Elements’ new Photo Text 

guided edit makes it drop dead simple 

to achieve. The feature lets you choose 

from the fonts within your system and 

even lets you add an embossed look 

and drop shadows for a pro finish.

Just choose the Type tool and start 

typing. You can select and cycle 

through all the selections to help you 

decide. After you choose your font, 

you can enlarge, fit, and apply some 

simple effects. Occasionally, this 

feature had glitchy performance; I’d 

choose a font and start typing 

without it registering any letters on 

the canvas. In that case, I cancelled 

and started over to achieve the 

advertised results.

Art transformation

Creating art from photos is swiftly 

becoming a worldwide phenomenon. 

PICK FROM 

YOUR own font 

collection; fat 

ones work best 

for stuffing in 

pictures.

PUT A PHOTO inside 

your text for that old-

time postcard look, or 

maybe a Springsteen 

album cover.

Photoshop Elements’ new Painterly 

module offers a nod to that by letting 

you add a canvas background or 

watercolor brush strokes to your 

photos. There are only five brush 

styles, but you can change their size 

and background color to alter the look. 

The module is aided by a minimal num-

ber of textures and effects.

I found this effect a little half-

baked. It’s understandable that 
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Adobe wants to keep the tool simple, 

but in the future, I’d like to see more 

enhancements with additional brush 

shapes and textures as well as better 

ways to blend them.

Multiple effects

The new Effects Collage guided edit 

allows you to construct an artistic 

presentation by carving up a single 

photo into several sectors, automati-

ADOBE PHOTOSHOP ELEMENTS 15 REVIEWCREATE

ORIGINAL PHOTO ART: 

Mask your photo, 

use textured brushes 

to reveal parts, 

layer texture in the 

background, and top 

off with a filter. 

THREE SPECIAL 

EFFECTS in one.
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cally adding a different special effect 

to each one. It’s an intriguing idea, 

but not every photo will lend itself to 

the limited number of effects combi-

nations offered.

It would be nice if you could adjust 

the borders yourself, though there were 

quite a number of selections to choose 

from in each preset. It would be great to 

choose which effects go where rather 

than just having to use the built-in 

template. But that’s a minor quibble with 

this cool feature, which dresses up 

mundane pictures in a pleasing way.

I also noted that this feature 

caused the fans on my Mac to whir, 

and that the application of the effects 

was not instantaneous.

Camera, action

Say you don’t know how or were 

unable to catch a cool motion shot? 

Or maybe the scene should have had 

more action than it really did? The 

new Speed Pan guided edit adds a 

motion blur behind your subject to 

create a feeling of movement. Just 

select the subject and let the soft-

ware do the rest.

Original frames

Photoshop Elements always shipped 

with many assets, including picture 

frames for scrapbookers and blog 

posters. Version 15 gives you Frame 

Creator, a new way to create your 

own custom frames instead of having 

to choose the app’s pre-made ones. 

The idea is to give users headroom 

to expand the capabilities of the 

software without having to use the 

built-in artwork. These new frames 

can be saved in the app’s frame 

format and used with any photo, plus 

A NATIONAL PARK 

Service horse carries 

a ranger through 

Central Park.
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you can share them with friends.

I found this to be one of the least 

intuitive guided edits. Despite the 

instructions accom-

panying each frame 

tool, the outcome 

was hard to visualize 

and involved too 

much experimenta-

tion for a reasonably 

quick result. It would 

have been easier 

had Adobe included 

some shapes in this 

module with ways to 

tweak the edges 

instead of depending 

on user sleight of 

hand.

ATTITUDE 

ADJUSTMENT

Photoshop Elements’ 

new Adjust Facial 

Features tech first 

originated in Photo-

shop Fix, and then 

migrated to Photo-

shop CC as the Face 

Aware Liquefy 

feature. Making faces 

look friendlier has 

come into vogue for 

everything from 

social media portraits 

to group shots and 

selfies. While I’m not 

ADOBE PHOTOSHOP ELEMENTS 15 REVIEWCREATE

a huge fan of enhancing people’s 

faces, some photos do benefit from 

that slight transformation of a neutral 

WHY USE BUILT-IN 

frames when you can 

create and share your 

own unique ones?
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expression into 

a smile. But 

that’s not all you 

can do.

You may want 

to correct a 

squint that goes 

with that frown, or otherwise 

make slight cosmetic changes 

to lips, nose, and even the 

shape of the face. But don’t go 

crazy, because applying these 

effects can distort the natural 

looks of your subject.

While the defining blue circle 

does not move and you can’t 

resize it—and on at least one 

image I tried—it cut right in the 

middle of the face, enlarging 

the image helps to rectify that 

issue. Also it would be helpful if 

each eye could be adjusted 

separately, as squints (and 

faces) are not necessarily 

symmetrical.

BETTER FILTERING

Filters are a great way to try on 

new looks for special or not-so-

hot photos, and an updated 

Filter Gallery not only lets you 

choose a cool filter but also 

fine-tune the details. You can 

easily try out each filter by 

clicking it, where it will apply 

directly onto the open photo, 

and then use individual controls 

TOP: Neutral 

expression. 

BOTTOM: Smiling 

face looks pretty 

natural, when 

nothing but a 

smile will do.
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to tweak. While the main filter was 

applied in real time, the advanced 

filter sometimes appeared in a small 

preview box that was harder to see.

BOTTOM LINE

Adobe Photoshop Elements 15 is a 

mature product that gets new and 

enhanced features on a yearly basis 

while keeping an elaborate and 

engaging interface consistent and 

easy to use. If you are a photo 

enthusiast who seeks special effects 

goodness without the learning curve, 

Photoshop Elements is the ticket. 

While I found at least two of the new 

guided edits less than compelling, 

improvements to the Organizer were 

uniformly useful.

For the very most part, Photoshop 

Elements 15 performed well without 

lag time on most operations, but 

occasionally I encountered glitches 

or intermittent buggy behavior. 

Adobe says that it recommends 

Elements for macOS Sierra, and 

despite a crash here and there, the 

app functioned as expected.

You can purchase Photoshop 

Elements together with Premiere 

ADOBE PHOTOSHOP ELEMENTS 15 REVIEWCREATE

MORE AND BETTER filters.
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Elements, its video-editing compan-

ion, for $150 (go.macworld.com/

elementsapp), or buy it alone for 

$100 (go.macworld.com/photo-

shopcc). A free 30-day trial version is 

available. If you have version 14, and 

the new guided edits are not com-

pelling for you, it would be an easy 

call to wait it out until next year to 

pay for an update. The upgrade 

policy is always the same: Any user 

with a previous version can upgrade 

for $80, or $120 for the bundle. If the 

new guided edits are something you 

will use frequently, or you have not 

upgraded for several iterations, you 

will be happy enough with the new 

version to lay down some cash. ■
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Learn how to use Photoshop Elements to combine photos to create a cool effect.

BY LESA SNIDER

How to use Photoshop 
Elements to combine  
images like a pro
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O
ne of the most exciting projects you can tackle in 
image editing software that supports layering— 
Adobe Photoshop, Photoshop Elements, Pixelmator, 
etc.—is to combine images in interesting ways. 

Whether you’re crafting a surreal piece of art or swapping heads, 
the process is similar in each program. In this column, you’ll learn 
how to use Photoshop Elements to combine a photo of an Italian 
villa and a glass of red wine in order to create a version of Italy 
you can drink.

COMBINE THE IMAGES INTO  

A SINGLE DOCUMENT, 

ROTATE AND RESIZE

1. Fire up the Elements Editor and 

click the Expert button at the top of 

the workspace.

2. Choose File → Open and locate 

the image you want to base the 

composite on, such as the wine glass 

shown here.

3. Summon the Layers panel by 

clicking the Layers button at the 

bottom of the workspace.

4. If the image needs rotating, 

choose Image → Transform → Free 

Transform. Point your cursor near 

one of the corner handles and when 

it turns into a curved arrow (circled), 

drag to rotate the image to your 

liking. To reposition the image, click 

and drag inside the box. When you’re 

finished, click the green checkmark 

beneath the image to accept the 

transformation (or press the Return 

key on your keyboard).

5. Add another image to the 

document by choosing File → Place. 

Navigate to where the other image 

lives on your hard drive and click 

Place.
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6. When the image opens, 

Photoshop Elements surrounds it 

with resizing handles. If you need 

to resize it, peek in the Tool 

Options panel and make sure 

Constrain Proportions is turned on, 

and then drag any corner handle to 

resize the image. Drag within the 

box to reposition the image if 

necessary. Click the green check-

mark beneath the image when 

you’re done.

MASK AND ADJUST COLOR

To hide a portion of an image you can 

use a layer mask. In this example, 

we’ll hide the sky in the villa image. 

Sometimes it’s easier to select what 

you don’t want and then invert the 

selection in order to select what you 

do want.

1. With the proper layer active, 

grab the Quick Selection tool from 

the Toolbox (circled).

2. In the Tool Options panel, adjust 

PHOTOSHOP ELEMENTS TO COMBINE IMAGESCREATE
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brush size and turn on Auto-Enhance 

(also circled).

3. Mouse over to the image and 

click, or click and drag, across the 

area you want to hide (the sky). The 

size of the area Elements selects is 

directly related to your brush size. If 

you select too much, Option-drag 

across that area to subtract it from 

the selection.

4. Flip-flop the selection by 

choosing Select → Inverse and then 

add a layer mask by clicking the 

circle-within-a-square icon at the top 

of your Layers panel. When you do, 

Elements hides the selected area.

5. To adjust the color of one layer 

so it looks more like the other layer, 

click the half-black/half-white icon at 

the top of your Layers panel (circled) 

and choose Hue/Saturation. In the 

panel that opens, turn on Colorize 

(also circled) and then adjust the Hue 

slider to your liking. You can also use 

the Saturation slider to adjust color 

intensity. To restrict the color change 

to one layer down, click the icon at 

the bottom left of the panel (it’s 

circled, too). Now the color change 

only affects the villa layer.

You can also use layer blend 

modes to control how colors on each 

layer blend or cancel each other out. 

To make as much of the grassy 
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foreground disappear as possible, 

activate the villa layer and from the 

menu at the top of the Layers panel, 

choose a different blend mode. 

Darker Color was used here as it 

looks at the colors on all layers and 

keeps only the darkest ones; it 

doesn’t blend any colors together.

Since the wine is darker than most 

of the foreground, a chunk of it 

disappears but that’s easy to fix.

1. Click the mask you created 

earlier (circled) and activate the 

Brush tool in the Draw section of the 

Toolbox.

2. Take a peek at the color chips at 

the bottom of the Toolbox (also 

circled) and press D to reset them to 

the default values of black and white, 

and then press the X key to flip-flop 

them so that black is on top.

3. In the Tool Options panel, pick a 

soft-edge brush from the Brush 

menu, adjust brush size, and then set 

opacity to 100 percent. Mouse over 

to the image and brush across the 

areas of the image that you want to 

hide. If you mess up and hide too 

much, press the X key to flip-flop 

your color chips so that white is on 

top and then brush back across that 

area. Remember, in the realm of the 

layer masks, painting with black 

conceals and white reveals.

ADD TEXTURE

Texture is a great way to make 

multiple images look like they go 

together, and Elements has a slew of 

textures built into the program.

1. To access them, click the Graphics 

button at the bottom of the workspace 

PHOTOSHOP ELEMENTS TO COMBINE IMAGESCREATE
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and scroll down 

until you find one 

you like (Oh So 

Dusty was used 

here). Single-click a 

thumbnail to 

download and add 

it to your document.

2. Click the 

Layers button at 

the bottom of the 

workspace to 

reopen your Layers 

panel. Locate the 

texture you added 

and then drag it to 

the top of your 

layer stack.

3. Use the menu 

at the top of the 

Layers panel to 

change the texture layer’s blend 

mode. If the texture seems too dark, 

ensure that layer is active and then 

adjust the Opacity setting at the top 

of the Layer panel. In this example, 

doing so reveals a couple of empty 

corners in the document created by 

rotating the image earlier. To fix that, 

click the half-black/half-white circle at 

the top of the Layers panel and 

choose Solid Color. In the Color 

Picker that opens, pick white and 

then click OK. Drag the fill layer to 

the very bottom of your layer stack.

If you’re happy with the composi-

tion, great. If not, continue adjusting 

color by double-clicking the Hue/

Saturation adjustment layer’s thumb-

nail to reopen the Hue/Saturation 

panel and/or experimenting with 

different blend modes for each layer.

The final piece is above, along 

with the Layers panel.

As you can see, compositing takes 

time but the results can be well worth 

the effort. ■
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Protect your photos and promote your services at the same time.

BY LESA SNIDER

How to watermark multiple 
photos in Lightroom
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W
atermarking your photos is a fantastic branding 
opportunity. It can also deter photo theft, and 
including your URL in the watermark ensures 
anyone who sees the image online can easily find 

you and book a session.

If you use Adobe Lightroom, you 

can create graphic or text-based 

watermarks quickly and easily, even 

though in Photoshop it takes far 

more effort. In this column, you will 

learn how to make a simple text-

based watermark in Lightroom and 

then apply it using the Export 

command.

CREATING A WATERMARK

To create a watermark, choose 

Lightroom → Edit Watermarks. In the 

resulting dialog box, turn on Text. In 

the field below the image, enter 

some text and be sure to include 

your URL. To copyright the photo, 

add a copyright symbol by pressing 

Option-G and then enter the year 



130

you took the photo followed by 

your URL.

Next, use the settings in the Text 

Options panel to format the text (you 

don’t even have to highlight it first). 

Turn on Shadow so the watermark 

can still be read if it lands atop a 

white background.

In the Watermark Effects panel, set 

Opacity to around 70. Choose 

Proportional in the Size section and 

use the slider to pick a size (say, 12). 

The Proportional option instructs 

Lightroom to resize the watermark so 

it looks the same no matter what 

dimensions you export the photo at.

Scoot the watermark away from 

the edges of the photo by entering 3 

into the Horizontal and Vertical fields 

in the Inset section, and then use the 

Anchor icon to position the water-

mark wherever you want. If you’d 

like, use the Rotate buttons to swing 

the watermark around so it runs up 

the side of your photo.

Click Save and in the resulting 

dialog box, enter a descriptive 

name, such as 2016 photolesa 

.com 12pt BR and click Create. 

From this point forward, your 

watermark preset is available in the 

Slideshow, Print, and Web modules, 

as well as the Export dialog box, 

which is discussed next.

Here the watermark name includes 

point size and location—BR for 

“bottom right.”

EXPORTING PHOTOS

When you use the Export command, 

Lightroom generates a copy of the 

photo(s) with all your edits intact. You 

can use it to rename, resize, change 

file format (say, from raw to JPEG), 

sharpen, and add a watermark to 

photos en masse. To do that, select 

several thumbnails by Shift- or 

Command-clicking them and then 

choose File → Export or, if you’re in 

the Library module, click the Export 

button at lower left.

In the dialog box that opens, 

expand the Export Location section 

of the dialog by clicking its title bar 

and then choose where you want 

the exported photos to go. Turn off 

Add To This Catalog to keep Light-

room from importing the exported 

copies into your catalog (the master 

file is already in your catalog, from 

which you can output other copies). 

Set the Existing Files menu to Ask 

What To Do.

In the File Naming section, turn on 

Rename To and pick the filename 

convention you want to use from the 

menu to its right or leave the name(s) 

as is. In the File Settings section, 

choose JPEG from the Image Format 

HOW TO WATERMARK IN LIGHTROOMCREATE
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menu and, if you’re exporting high-

quality files for your client or submit-

ting them to an online printing or 

stock photography service, set 

Quality to 100; otherwise, set Quality 

to 80. Pick sRGB from the Color 

Space menu (it’s the Internet stan-

dard) and the one used at most 

printing services.

If you want to resize the image, 

expand the Image Sizing section and 

turn on Resize To Fit. A handy option 

here is Long Edge, as it lets you 

resize both landscape and portrait 

oriented images at the same size. If 

the image is bound for the web, set 
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the measurement field to Pixels and 

enter 800 to export an image that is 

800 pixels wide on its longest edge, 

whether that’s height or width, and 

then leave Resolution at its default 

value. If you’re preparing photos for 

print, preserve the photo’s pixel 

count by leaving Resize To Fit turned 

off and then enter a resolution that’s 

best for your printer—300 pixels per 

inch (ppi) is adequate for most 

desktop inkjet printers and online 

printing labs. That said, if you’re 

preparing photos for inclusion in 

National Geographic magazine, ask 

them what resolution is best to use. 

HOW TO WATERMARK IN LIGHTROOMCREATE



133

When you’re exporting images for 

online use, resolution doesn’t matter 

because it refers to the number of 

pixels per printed inch.

In the Output Sharpening section, 

turn on Sharpen For and choose 

Screen from the menu to its right 

and then set the Amount menu to 

Standard. When you resize a photo, 

it becomes a little less sharp, so 

extra sharpening is a good thing. 

When exporting a photo for print, 

choose either Sharpen For → Matte 

Paper or Sharpen For → Glossy 

Paper, depending on the kind of 

paper you’ll use.

In the Metadata section, choose 

Copyright & Contact Info Only from 

the Include menu. In the Watermark-

ing section, turn on Watermark and 

pick the watermark you made from 

the menu. In the Post-Processing 

section, choose Show In Finder to 

have Lightroom open the location of 

the exported files when the export is 

complete. If you’ll use these settings 

again, click Add at the bottom of the 

Preset column to save them as a 

preset. Last but not least, click Export 

and Lightroom prepares your pho-

tos—you don’t even have to wait until 

it’s finished to do something else 

because exporting takes place in the 

background.

As you can see, it’s a snap to 

watermark photos in Lightroom. ■
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Solutions to your most vexing Mac problems.

BY GLENN FLEISHMAN

How to troubleshoot a swollen Photos cache folder
Q: I have a massive Photos library and use iCloud Photo Library stored on 

an external HD to maintain a local backup of all pictures. However, my wife 

and I use a large number of shared albums to share our pictures with each 

other, and these keep eating up space on my MacBook Pro in com.apple.

cloudphotosd. My MacBook Pro keeps filling up, rendering Photos completely 

unusable.

— Michael McKissack

A: You’re not alone in experiencing this! And it’s definitely a loose thread in 

how Apple manages photo storage. The ~/Library/Containers/com.

apple.cloudphotosd folder is a cache, not part of your Photos library. It’s 

used both for temporary storage, as images are synced and transferred to 

PHOTO: COURTESY OF APPLE
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your library, and as local storage for 

shared iCloud images.

For most people, shared iCloud 

albums don’t add up to much. But 

because you and your wife are 

sharing a lot of images—and I’d guess 

you might even be shooting and 

syncing in a raw photo format, which 

makes files even bigger—your cache 

is enormous.

Even if you have Photos set to 

optimize images and videos (in 

Photos → Preferences → iCloud) 

instead of storing full-resolution 

media, shared iCloud album remain 

cached at full resolution. For a 

less-frequent iCloud Photo Sharing 

user, this folder only consumes about 

1.5GB of my startup volume.

The bad news is that this is a 

design flaw, rather than a bug. Apple 

intentionally stores data there. As 

long as you’re sharing lots of images, 

this will remain a problem.

You can reduce the number of 

shared albums to reduce the storage 

consumed. Select any shared album 

and click the strangely named People 

button at upper right (it’s a silhouette 

of a person with a circle around it). 

You can then click Delete Shared 

Album, which empties the local cache 

without deleting the photos you 

shared, and disables sharing to other 

people.

Some users have reported on 

forums a related problem: that files 
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already synced to 

their Photos library 

or which no longer 

shared are still 

lodged in the com.

apple.cloudpho-

tosd folder. You 

need to delete that 

folder to refresh the cache, appar-

ently; that worked for many of those 

who tried it.

Warning! This requires temporarily 

disabling iCloud Photo Library. If you 

have a large library synced with 

iCloud, disabling and later re-

enabling it will cause a complete 

re-sync, even if no new images need 

to be uploaded. Consider your 

bandwidth use and the amount of 

time it will take.

To delete the folder:

REMOVING ICLOUD-

SHARED LIBRARIES 

reduces cached data 

on your startup disk.
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macOS Sierra or iOS 10 possibly 

because it’s required to use the 

watchOS 3 feature that lets you 

unlock your Mac with your Watch.

The point of friction, however, is 

with software that Apple hasn’t tied 

into iCloud. So that includes BusyCal 

and Fantastical, third-party email 

clients, and contacts apps other than 

Apple’s Contacts. Those can’t yet (or 

maybe will never be able to) use 

Apple’s 2FA to let you validate a 

login. With Apple’s system, whenever 

you log in using an Apple ID pro-

tected by 2FA, all of your associated 

iOS and macOS devices pop up a 

tiny map of the rough location and a 

pair of buttons to allow or reject the 

login. Tap or click Allow, and the 

device on which you’ve done so 

displays a six-digit code you have to 

enter to complete the login.

For services and software that isn’t 

tied in that way, you need to generate 

an app-specific password, which was 

also the case with the older two-step 

method. If you turned off two-step and 

turned on two-factor, all your previous 

1. In Photos → Preferences → 

iCloud, disable all options.

2. Quit Photos.

3. Select Go → Go To Folder in the 

Finder and paste in ~/Library/

Containers and click Go.

4. Delete the com.apple.cloud-

photosd folder.

5. Empty the trash.

6. Launch Photos and re-enable 

your options. 

Any shared albums will be re-

downloaded and cached as before.

How to fix two-factor 
authentication problems 
with apps that don’t use 
iCloud
I’ve heard some confusion and 

frustation from people who use 

calendar, contact, and email software 

that isn’t set up through iCloud, and 

they turned on Apple’s two-factor 

authentication (2FA). There’s an easy 

solution, but it requires a little plan-

ning and fuss to put it in place.

The more modern 2FA system 

Apple explicitly labels “two-factor 

authentication” replaces its previous 

“two-step verification,” which was a 

stop-gap put in place two years ago. 

The new 2FA is deeply integrated into 

iOS and macOS, and was introduced 

on a slow rollout to users about one 

year ago with iOS 9 and El Capitan.

Many people have apparently 

turned 2FA on for the first time with 

NAME YOUR APP-

SPECIFIC password so 

you can recall which 

service is using it if 

you need to revoke 

it later.
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app-specific passwords 

were wiped out! This is 

a shame, but you’re 

starting with a clean 

slate, so apps and sites 

you approved long ago 

and no longer use are 

no longer a potential 

threat, too.

To create an app-

specific password, follow these 

steps: 

1. Log in to your account at 

appleid.apple.com, which will include 

the map popup and a six-digit code.

2. In the Security section under 

App-Specific Passwords, click 

Generate Password.

3. Label the password so you can 

remember it later if you need to 

disable it, and click Create.

4. In the next screen, copy and 

paste or refer to the password and 

enter it in the app or service with 

which you need to use it. The pass-

word can never be viewed again, but 

it’s stored.

5. Click Done. 

You can manage the passwords 

you’ve created in order to revoke 

them, too. Click the Edit button next 

to the Security section, and then 

you can click View History under 

App-Specific Passwords. The list 

shows the creation date of each 

password, and you can click the x 

box to the far right to revoke any of 

them. You can also click Revoke All 

and wipe out all your app-specific 

passwords if you’re concerned 

about any of your software or 

Web-based services being hacked. 

This doesn’t affect your 2FA login 

at all.

I’ll note that Apple only shows the 

creation date of these passwords, 

while Google more helpfully in its 

2FA Web support shows the last time 

each was used! Much more useful, 

and I wish Apple would move to that 

approach.

How to merge iPhoto and 
Photo libraries on a Mac

Q: How can I know whether the 

pictures in the iPhoto library are 

also in the Photos library? How can 

I move a portion of the older 

images away while keeping the last 

few years on the laptop?

— Christoph Stork

I CAN SHOW you 

this app-specific 

password, because I 

immediately revoked 

it. That’s one of the 

advantages of this 

kind of password.
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A: Christoph Stork’s photo libraries 

are overflowing. He owns a MacBook 

Pro with a 750GB drive, but has an 

iPhoto library that weighs in at 190GB 

and a Photos library that takes up 

250GB. His drive is almost full and 

he’s not sure how to proceed.

If you followed the steps to import 

your iPhoto library into Photos when-

ever you started using Photos, all of 

the library’s full-resolution images 

weren’t duplicated. Instead, Apple 

chose to use “hard linking,” which 

Jason Snell explained (go.macworld.

com/photososxtricks) back in April 

2015. Instead of creating a copy of the 

iPhoto media, hard links just allow the 

same file to be linked in two or more 

places. Unlike an alias, which has a 

special icon and just points to another 

file, the hard link reference looks and 

acts exactly like it is a file.

This means that, in this case, the 

190GB and 250GB iPhoto and Photos 

library likely contain a whole lot of 

overlap. Thumbnails, modified images, 

and other internal data structures 

aren’t duplicated from iPhoto, and 

take up separate space in each 

library. New images imported into 

Photos would explain its larger size.

My suggestion for proceeding in 

this and similar cases is to get an 

external 1TB (or larger) USB 3.0 drive, 

which are relatively cheap. Copy the 

iPhoto library there before deleting it. 

(Deleting a file that’s hard linked in 

other places only deletes a refer-

ence; the original file remains in 

place for its other uses, so don’t 

worry about that.)

For as long as older versions of 

iPhoto continue to work, you can 

open any library on a mounted 

volume by holding down Option at 

launch, and then navigating to the 

library and selecting it. The same is 

true for Photos, although Photos 

continues to be updated, and should 

work across many, many future 

macOS releases.

If you want to archive part of your 

Photos library, get PowerPhotos 

($30; go.macworld.com/powerpho 

tos), a third-party app that has a lot of 

features missing in Photos. It will let 

you create a new library and copy 

images over, rather than using an 

awkward export method.

To find just older images, I suggest 

creating a Smart Album with the crite-

ria for the date range you want, and 

then selecting all the images in the 

Smart Album and creating a regular 
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album from it. You can then use 

PowerPhotos to create a new Photos 

library, copy that regular album and 

all its contents to the new library, and 

delete the album and associated 

media from your main Photos library.

PowerPhotos includes a license for 

iPhoto Library Manager, which has 

similar features. Both apps can 

identify duplicates within a library to 

reduce a library’s size if you have 

many images that were imported 

multiple times or duplicated internally.

I highly recommend making more 

than one backup of the photos and 

libraries you migrate off your main 

drive. It can be cheap to store data 

you don’t plan to modify at Amazon 

S3, or you can use Google Drive, 

iCloud Drive, or other options. ■
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Ask Mac 911
We’ve compiled a list of the most 

commonly asked questions we get, 

and the answers to them: read our 

super FAQ (go.macworld.com/

mac911faq) to see if you’re covered. 

If not, we’re always looking for new 

problems to solve! Email us at 

mac911@macworld.com including 

screen captures as appropriate. 

Mac 911 can’t provide direct email 

responses or answers for every 

question. For that, turn to Apple-

Care, an Apple Store Genius Bar, or 

the Apple Support Communities.


